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It takes all of us to beat cancer. 
Doctors, researchers, volunteers, 
and most importantly, people like 
you. Join the movement to beat 
cancer at StandUp2Cancer.org
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MACUSER News and Analysis About 
Macs, OS X, and AppleMACUSER News and Analysis About 
Macs, OS X, and Apple

Jason Snell shares his hopes for Apple’s Mac lineup in the new year.

BY JASON SNELL

What the Mac needs in 2016

6
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A NEW NAME FOR OS X
I’ve banged this drum (go.macworld.
com/namechange) a couple of times 
(go.macworld.com/endofosx) this 
year, but 2016 seems like the right 
time for Apple to retire the “big X” 
and put the Mac back in OS X.

In 2015, we saw tvOS and 
watchOS join iOS in Apple’s operat-
ing-system portfolio. In 2016, it 
seems only logical that macOS join 
them. (No, I’m not thrilled about the 

capitalization either, but I suspect 
we’ll get used to it.) Only Macs run 
OS X, and the X seems like a relic of 
the late ’90s now. Bring back the 
Mac! Er, “mac.”

AN IMPROVED  
MAC APP STORE
The Mac App Store finally got a 
renewed focus in 2015—as in, writers 
and pundits focused on the missteps 
that led to Mac users being told their 

The end-of-the-year tradition of list-making and reflection 
on the past, as well as pondering the future, often spills 
into the new year itself. Our foothold in 2016 is now 
complete. I’ve taken down my old calendar and put up 

the new one, a practice that always stokes my curiosity about 
what’s to come. I can’t actually peek into the future, but I’d like to 
share a list of things I hope we see from the Mac in 2016.

PODCAST
Tap to listen to our 
podcast about 
Jason Snell’s 2016 
predictions.
go.macworld.com/ 
2016predictions

7

http://www.softgozar.com


MACUSERMACUSER

apps were damaged and should be 
thrown in the Trash.

When the Mac App Store 
launched, we were all excited by the 
possibility that it would do for Mac 
software sales what the App Store 
had done for iOS apps. Unfortu-
nately, the developers of more 
complex apps have been frustrated 
by Apple’s security demands and 
the limitations of the Mac App Store 
itself. Some key Mac apps have 
never been allowed into the store, 
and many more—including, most 
recently, Sketch (go.macworld.com/
sketchleaving)—have given up and 
pulled out.

In 2016 I’m hoping Apple refo-
cuses on the Mac App Store, and 
makes it worthy of the Mac platform. 
The Mac is fundamentally a more 
complex, rich system than iOS. That’s 
its advantage, and why it continues 
to exist. Why apply iOS standards to 
the needs of Mac users? It was 
understandable that the Mac App 
Store would launch as nothing more 
than a copy of the iOS App Store, but 
it’s been years now.

In particular, I’d like to see Apple 
improve the App Store app, relax its 
restrictions on what apps are 
allowed in the Mac App Store so that 
more complex products can be 
allowed entrance, and introduce 
support for trial periods and paid 
upgrades. (The later in the list, the 

less likely it is to happen, but we live 
in hope.)

THUNDERBOLT 3, 
EVERYWHERE POSSIBLE
Intel announced this year that 
Thunderbolt 3, the new generation 
of the high-speed connection 
technology, will be plug-compatible 
with USB-C ports. In an ideal world, 
this would be the port that Apple 
could standardize on for all of its 
computers across its entire line, 
providing USB compatibility along 
with the speed and flexibility of 
Thunderbolt.

Not every Mac released in 2016 
will support Thunderbolt 3, but I’m 
hopeful that by the second half of the 
year, it’s standard issue on all of 
them. Imagine a single, small port 
that’s capable of attaching just about 
any peripheral you can think of, 

WHAT THE MAC NEEDS
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including a 4K external display. In 
2016 we should see it, and it should 
allow Apple to finally avoid offering 
both Thunderbolt and USB ports on 
almost all of its Macs.

A RETINA EXTERNAL DISPLAY 
FROM APPLE
Every Mac power user I talk to 
seems to want a Retina successor to 
Apple’s Thunderbolt Display. So why 
hasn’t it happened? It’s probably 
some combination of connection 
technologies and available graphics 
processing power, but in 2016 it 
should finally be possible. If it uses 
Thunderbolt 3 and works with a new 
round of Mac Pros and MacBook 
Pros, all the better.

A MACBOOK UPGRADE
The new MacBook is a fun, 
interesting laptop, but 2015’s model 
has the feel of being a bit too far on 
the cutting edge. Perhaps a new 
model for 2016 could upgrade its 
USB-C port to Thunderbolt 3, or at 
the very least add a second USB-C 
port? Improving the keyboard 
wouldn’t be a bad move, either.

RETINA SPREADING ACROSS 
THE iMAC LINE
In 2015, Apple made every 27-inch 
iMac a 5K iMac. This year, it should 
do the same for the 21.5-inch 4K 
model, getting non-Retina out of the 
iMac range at last. (A more likely 
scenario is a single, low-cost non-

9
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Retina model remaining in the 
product line.)

THE DEATH OF SPINNING 
HARD DRIVES
Speaking of the 21.5-inch iMac, even 
the base configuration of the 4K iMac 
is equipped with a spinning hard 
drive. This is old, slow technology 
that doesn’t have a place on new 
Macs sold in 2016. So here’s hoping 
for the abolition of that technology, 

with only Fusion Drives (a spinning 
hard drive augmented by a small 
amount of speedy flash storage) and 
pure Flash Storage in the mix.

People make a big deal about Apple 
being famous for abolishing outmoded 
technologies and forging ahead—
floppy disks, optical drives, maybe 
even the 3.5mm headphone jack—but 
it’s clung to the classic hard drive too 
long. Time to turn the page and recall 
it as a dim memory of 2015 past. ■

WHAT THE MAC NEEDS
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You might know Joshua.  
He loves video games, and he 
owns enough to know they’re not 
all meant for kids. That’s why he 
reminds his friends (at least the 
ones that have kids) that they all 
have big black letters on the box 
to help parents find the ones that 
are best for their families.  

You can learn about those
ratings at ESRB.org

Los Angeles, CA
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Cannibalism is good, and 
other things I learned from 
60 Minutes’ Apple report
Charlie Rose talked to Tim Cook on 60 Minutes, and the interview was enlightening.

BY MICHAEL SIMON

MACUSER
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A n inside look at Apple’s laboratories isn’t as rare as  
it once was. Over the past year, Apple has opened  
up its doors to Good Morning America, Backchannel  
(go.macworld.com/backchannel) and The New Yorker 

in a seeming effort to change its image as an ultra-secretive, 
inaccessible company ruled by the specter of an iron fist. 60 
Minutes’ Charlie Rose was the latest journalist invited into the 
inner sanctum, and Apple practically rolled out the red carpet for 
him.

But while Rose didn’t uncover any real 
secrets (at least none that he told us 
about), his report was fascinating 
nonetheless. Every peek we’ve gotten 
in the media has shed the smallest 
sliver of light on Apple’s private 
operations, but Rose’s report wasn’t 
the usual sanitized glimpse at life 
within Apple’s walled garden. 
Throughout the tour, he revealed 
more than just how Tim Cook, Phil 
Schiller, and Eddy Cue operate 
between the public unveilings of new 
products; he showed a remarkably 
human side of both the company and 
its CEO, and even uncovered a few 
surprises along the way. Here are five 
things I learned:

TIM COOK IS COMFORTABLE 
LIVING IN STEVE JOBS’S 
SHADOW
Cook has every right to want to 
distance himself from his larger-than-
life predecessor, but when Steve 
Jobs’s name was uttered—before 

Rose took a single step onto Apple’s 
campus, mind you—he was respectful 
and reverent in a way that suggests 
he misses him as a friend more than 
an inventor. Everything Cook does is 
viewed through the prism of Jobs’s 
genius, and in many ways his legacy 
has already been written; even if he 
succeeds, Steve will receive much of 
the credit, having built Apple from a 
company on the brink of bankruptcy 
into one of the largest in the world.

It would be easy for Tim Cook to 
rattle off his own accomplishments—
after all, he was with Steve nearly 

TIM COOK and Steve 
Jobs at a 2010 press 
conference.
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every step of the way—and talk about 
how Apple is different now, with a 
whole line of products designed after 
Jobs, but instead he spoke in glowing 
terms, saying, “I’ve never met anyone 
on the face of the earth like him 
before…who had this incredible and 
uncanny ability to see around the 
corner. Who had this relentless driving 
force for perfection.”

He even invoked one of Steve’s 
famous phrases, “insanely great,” 
when talking about Apple’s drive for 
perfection. It didn’t seem like lip 
service, and while some people want 
to believe that Apple’s halls are 
haunted, Cook made it seem like 
they’re blessed, even protected, by 

its late founder.
“I loved Steve. Steve is not my 

competition,” he said. “He selected 
me. I want to do every single thing I 
can do and use every ounce of 
energy I’ve got to do as well as I can.”

APPLE’S ATTENTION TO 
DETAIL HAS NO LIMITS
No tour of Apple is complete without 
a trip to Jony Ive’s laboratories. Rose 
spent a good deal of time there, 
looking at Apple Watch sketches, a 
CNC milling machine that carves out 
precision prototypes, and some of the 
hundreds of color shades that weren’t 
quite right for the bands. It was cool to 
see the behind-the-scenes process, 

‘60 MINUTES’ REPORTMACUSER
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but even cooler were the ten iPhone 6 
prototypes we were shown. Before 
the 4.7- and 5.5-inch displays were 
chosen, Ive and his team went 
through nearly a dozen handsets in 
varying sizes and finishes to see 
which one “felt right…emotionally.”

Ive continued: “We’ve found that 
different textures considerably impact 
your perception of the object, of the 
product, what it’s like to hold, and 
what it’s like to feel. So the only way 
that we know how to resolve, and 
address, and develop all of those 
issues is to make models, is to make 
prototypes.” But while it sounds 
exhausting, there is very little turn-
over in the most sacred of spaces at 1 
Infinite Loop. In 15 years, Rose 
reported, just two of Ive’s team of 22 
designers have left.

When Rose took a trip to the 
construction site of Apple’s new 
campus, Cook explained how no 
detail was overlooked: “This goes 
down to…it goes to the desk, the 
chair, the stairwell, the doorknob, the 
glass—I mean, every single thing.” 
That includes the hard hats. Not only 
were they white with gray Apple 
logos on them, Ive’s was inscribed 
with his last name, much like the cap 
of a pro baseball player. And I’d be 
surprised if it wasn’t custom fitted for 
the shape and size of his head.

Along the way, Rose was treated to 
a scale representation of a future 

Apple Store. It was beautiful, incred-
ible and crazy all at once; listening to 
Angela Ahrendts describe how they 
want to bring the “dynamic, emotive, 
immersive” 
to life inside 
the Apple 
Store was 
eye-open-
ing. I always 
chalked up 
the Apple 
Store crowds to people wanting to 
see their products, but it’s more than 
that. Everything from the doors to the 
shelves to the lighting is specifically 
designed to draw you in and keep 
you interested.

APPLE ISN’T BACKING DOWN 
FROM THE U.S. GOVERNMENT
Fighting Samsung isn’t the only 
battle Apple is waging in U.S. courts, 
and Cook wasn’t shy about speak-
ing out on the two major ones: 
encryption and taxes. And it doesn’t 
sound like he’s going to stop 
fighting either.

It was refreshing to hear a CEO 
answer a couple of hard-hitting 
questions without eluding them. 
There are many who disagree with 
him—including BlackBerry CEO John 
Chen—but it’s hard not to admire 
Cook’s matter-of-fact stance. When 
asked about handing over informa-
tion in a criminal case, Cook was 

IN 15 YEARS, ROSE 
REPORTED, JUST TWO 
OF IVE’S TEAM OF 22 
DESIGNERS HAVE LEFT.

15

http://www.softgozar.com


resolute in protecting the user: “If the 
government lays a proper warrant on 
us today then we will give the 
specific information that is 
requested,” Cook said. “In the case 
of encrypted communication, we 
don’t have it to give. And so if your 
iMessages are encrypted, we don’t 
have access to those.”

There isn’t much of a gray area. 
Cook outright dismissed the notion 
of a so-called back door—“The reality 
is if you put a back door in, that back 
door’s for everybody, for good guys 
and bad guys”—and called the idea 
of privacy versus security “overly 
simplistic.” “We’re America,” he said. 
“We should have both.”

When pressed on the issue of 
taxes—Apple has some $75 billion 
stashed overseas, and the U.S. 
government is fighting to force the 
company to bring back—Cook was 
just as blunt. He admitted to taking 
advantage of a legal loophole to 
avoid the 40 percent penalty and 
called out Congress for refusing to 
update a tax code “that was made 
for the industrial age, not the digital 
age.” And he called the case against 
Apple “total political crap.”

The fight is likely to go on for many 
years, but if the government thinks 
Apple is going to bow to public 
pressure, it has another thing com-
ing. Cook could have easily taken a 
broad, political route on such a 

national stage, but he chose to attack 
the issue head-on.

APPLE HAS ONLY SCRATCHED 
THE SURFACE IN CHINA
Over the past several quarters Apple 
has been enjoying tremendous 
growth in the Middle Kingdom, and 
with 1.3 billion inhabitants, it doesn’t 
take an expert to see that it’s a major 
market for Apple. But Tim Cook 
thinks it will eventually become 
Apple’s biggest: “The numbers tell 
me that. And not just the numbers of 
people, but the numbers of people 
moving into the middle class. That, 
for a consumer company, is the thing 
that really begins to grow the market 
in a big way.”

But even more than the growth 
opportunity, Apple’s manufacturing 
ties to China are equally important. 
Cook bumbled through a question 
about whether cheap labor was the 

‘60 MINUTES’ REPORTMACUSER

CHINESE CUSTOMERS 
testing out iPads.
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primary reason for building the vast 
majority of its products in China, 
citing workers’ skill level as the 
primary motivator, and he was clearly 
uncomfortable during that segment 
of the interview, particularly when 
asked about the safety and wages of 
workers.

“We have a responsibility and we 
do it,” Cook said. “We are constantly 
auditing our supply chain, making 
sure that safety standards are the 
highest. We’re making sure that 
working conditions are the highest. 
All of the things that you would 
expect us to look for and more, we’re 
doing it.”

But as China becomes an increas-
ingly bigger market, these issues will 
only become more illuminated. It’s 
not a problem unique to Apple, but 
as the largest manufacturer in the 
world, it has an obligation to take the 
lead, which Cook is doing. But Apple 
still has a long way to go.

PRODUCT CANNIBALISM IS 
GOOD FOR BUSINESS
But the most interesting comment of 
the report came from Phil Schiller. 
Rose asked a very pointed question 
about the inherent overlap in Apple’s 
various product lines, from iPhones 
to iPads to Macs. I expected to hear 
a stock answer about how Apple 
builds products people need and 
strives to fill all needs, but instead 

Schiller embraced the scary notion of 
cannibalism.

“It’s not a danger, it’s almost by 
design,“ he said. ”You need each of 
these products to try to fight for their 
space, their time with you. The 
iPhone has to 
become so 
great that you 
don’t know 
why you want 
an iPad. The 
iPad has to be 
so great that 
you don’t 
know why you 
want a 
notebook. The notebook has to be 
so great, you don’t know why you 
want a desktop. Each one’s job is to 
compete with the other ones.”

I’ve never thought of it that way, but 
it makes a lot of sense. To make a 
great product, it obviously has to hold 
its own against all others in its class, 
but it also has to embrace its compro-
mises and understand its weak-
nesses. Apple devices are at once 
complementary and competitive, and 
to use one is to want, though not 
necessarily need, another.

It’s a relentless focus and pursuit 
of what’s best for the user. And 
whether we’re talking about  
China, encryption, or retail stores, 
Apple isn’t about to give up the  
good fight. ■

APPLE DEVICES ARE AT 
ONCE COMPLEMENTARY 
AND COMPETITIVE, 
AND TO USE ONE IS TO 
WANT, THOUGH NOT 
NECESSARILY NEED, 
ANOTHER.
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Reviews
MACUSER

MAC GEMS ARE APPS THAT OFFER 
STANDOUT UTILITY OR UNIQUE 
FEATURES AT A GREAT PRICE.

WHILE APPLE’S PHOTOS IS STREAMLINED and zippy compared to 
iPhoto, its stripped-down approach can be confusing. PowerPhotos 
(fatcatsoftware.com/powerphotos) takes some of the shock out of 
Photos for OS X by helping bridge the gap between old and new. Fat 
Cat Software’s app offers assistance in migrating iPhoto libraries, 
managing (and merging) multiple Photos libraries, and offers a differ-
ent way of viewing images and videos. It’s more flexible, to be sure.

When launched, PowerPhotos shows—under an Operations 
listing—Migrate iPhoto Libraries, which can also be selected later 

 PHOTOGRAPHY

POWERPHOTOS 
1.1: NOW WITH 
LIBRARY MERGES, 
ALBUM COPY, 
AND SEARCH 
ACROSS 
LIBRARIES
BY GLENN FLEISHMAN

POWERPHOTOS 1.1

mmmmm
PRICE WHEN RATED

$30
COMPANY

Fat Cat Software
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from the File menu. This lists all iPhoto libraries that it can find via 
Spotlight; you can add others manually.

The migrate operation lets you manage creating Photos-compatible 
libraries without babysitting the Photos app, and shows progress and 
errors. It can also migrate several libraries from the same interface 
instead of requiring multiple iterations of quitting and launching Photos 
with the right key held down.

In the 1.1 update, the app added the ability to merge Photos libraries 
as well as copy images and albums to existing or new Photos libraries. 
This dramatically expands its utility; its price also was bumped from $20 
to $30, but it bundles a fully licensed copy of its predecessor, iPhoto 
Library Manager (fatcatsoftware.com/iplm), which can merge iPhoto and 
Aperture libraries before you import them into Photos. (Existing owners 
of that product can upgrade for $15.)

MERGING LIBRARIES AND FINDING DUPLICATES
Once you have Photos libraries migrated from iPhotos or created anew, 
you can use PowerPhotos’ Merge Libraries and Find Duplicate features, 

POWERPHOTOS’ FIND 
Duplicates feature creates 
an album with all the images 
marked as duplicates that 
you accepted.
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which employ different strategies through a very similar interface. Those 
waiting to upgrade to Photos until a point at which they could merge or 
at least rationalize various libraries can now take the plunge.

Select Library → Merge Libraries, and an item appears in the left 
navigation bar under Operations. Select it and you can then drag 
libraries in the Photo Libraries list into the Choose Source Libraries area. 
(At this writing, the text in that area is incorrect.)

In the next step, you choose whether to merge into an existing library 
or create a new one as the product of the merger. You can then, in step 
3, select duplicate handling, which will de-duplicate within a single 
library (described below) and across multiple merging libraries.

REVIEWS  |  POWERPHOTOS 1.1MACUSER

THE MERGE LIBRARIES options 
are elaborate, allowing fine 
control over the results.

THE PREVIEW during Merge 
Libraries lets you inspect 
which duplicates were found.
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Finally, step 4 offers 
merger-specific options, 
which includes a few 
general items, like merging 
albums with the same 
name, and one critical 
radio-button choice: 
whether to import originals 
or edited versions. If you 
select the former, any edits 
made in Photos aren’t 
copied, only the original 
image as imported; select 
the latter, and originals are 
copied for unedited images 
and videos, but for Photos-
edited images, only the 
resulting JPEG stored in 
Photos is copied over.

You can click Preview to 
have it run an analysis 
before completing the 
operation, and see both the 
resulting library and any 
duplicates found.

Another version 1.1 feature lets you take selected photos or albums 
and drag them into another library. This doesn’t remove them from the 
original—that’s a separate step you have to take within Photos. So if you 
want to split a library into multiple libraries, you should use Photos to 
create albums, then use PowerPhotos to duplicate those albums into 
new or existing libraries, and finally delete them via Photos from the 
original library.

If you don’t have libraries to merge (or split), you can use the Find 
Duplicates feature to reduce the size of your corpus and remove the 
detritus of year’s past—duplicate imports you may have made 
accidentally.

I apparently have 43,169 photos in my master Photos library, and I 

WHEN A MERGE IS complete, PowerPhotos offers a summary of what it did.

AN IMAGE DEEMED to be a duplicate that should be discarded can be swapped to be the 
one kept, among other operations.
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hadn’t spotted many duplicates in my perusal. PowerPhotos found over 
1000! If you have multiple Photos libraries, you can scan across them, too.

The app gives you several choices for deciding how to let it identify 
duplicates (whether in Find Duplicates or Merge Libraries), including the 
option to exclude hidden photos, images marked with “duplicate” in the 
keyword field, and photos that it’s already placed in a special album. 
Comparisons can be based on the content of an image (Exact Match), 
which looks for byte-for-byte identical versions of either the original image 
or any modified version you’ve stored. Or, you can opt for filename and 
date, which includes minor variations in filenames commonly used with 
duplicates. (Merge Libraries uses these criteria, but also adds an option to 
remove duplicates while merging, and to use additional metadata criteria 
to sort out which image should be kept in the merge operation.)

Even with my huge library and using exact matches, it only took about 
20 minutes on a 2014 Mac mini while I continued to work on tasks in 
other apps. Once the pass is complete, you can review pairs or multiples 
of images and make sure your matches are correct. If not, you can 
switch which image in a set you want to be the “keeper,” or discard the 
match entirely, among other options.

When you’re done reviewing and click Apply, instead of deleting the 
files or moving them to the trash, the images are placed by default into a 
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THE FIND DUPLICATES feature 
allows exact image matching 
or matching against a 
combination of filename 
and date.
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special duplicates album, which you can then review in Photos to dump 
into the trash.

LIBRARY MANAGEMENT 
While you might use Find Duplicates once or rarely, the ability to easily 
review and switch among multiple Photos library is a must-have feature 
for many users, based on the email we’ve received at Macworld. Some 
iPhoto users set up multiple libraries, one per year, or with other divi-
sions that they want to maintain and have access to. PowerPhotos can’t 
overcome iCloud Photo Library’s limit: one Photos library is a master to 
which iCloud syncs.

With a Photos library selected, PowerPhotos lets you select Moments 
as items in its navigational column. Albums and Smart Albums are also 
shown. But where it shines compared to Photos is with its list view and 
in a middle ground for search between Photos’ very basic option and 
Smart Albums.

Click the list icon at upper right, and PowerPhotos shows a thumbnail that 
can be sized from tiny to enormous, and then a host of associated data, 
allowing easier scanning through and sorting. By default, it just shows a few 
items, like Title and Date. But pop into the View → Show Columns items list, 
and you can add Description, Place, Faces, Size, and more.

This works well in association with its find feature. Type in a word or 
more, and PowerPhotos searches across all of an image’s file data and 

MIGRATING LIBRARIES from 
iPhoto and Aperture to 
Photos can be managed 
with more élan within 
PowerPhotos.

23

http://www.softgozar.com


metadata. But then you can opt to broaden to search across all libraries 
the app is managing, and narrow to match that text only across Title, 
Filename, Keywords, Faces, Place, Description, and Moment. While you 
can achieve this with a single library using Smart Albums in Photos, it’s 
not interactive nor can it provide the compact density of a detailed list.

BOTTOM LINE
PowerPhotos is an extremely useful addition as an enhancement for any 
Photos user trying to perform tasks that fall outside of Photos restricted 
purview. With the addition in Photos 1.1 of merging libraries and copying 
images and albums across libraries, it’s become invaluable for longtime 
iPhoto and Aperture users trying to make sense of moving forward. And 
its utility features—including identifying duplicates, multi-library and 
metadata searching, and other bits and pieces—show the ongoing worth 
of having it in your arsenal. ■
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THE LIST VIEW in PowerPhotos 
provides a lot of detail in a 
compact format for quick 
scanning.
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OH, SPAM. THERE IS SO MUCH OF IT. Some estimates say that 90 
percent of email sent around the world is spam. Sometimes it’s hard 
to sort the wheat from the chaff; or the ham from the spam.

It’s been a plague since the earliest days of the Internet. Whether 
it’s spam that contains attachments—which, if opened, could hijack 
your computer (though most often, these attachments carry Windows 
malware)—or phishing emails that try to trick you into entering your 
bank or Apple ID credentials on dodgy websites, spam is both an 
annoyance and a danger.

There are several ways you can block spam. If you use Gmail or 
iCloud for your email, there are built-in spam filters. In Gmail you can 
view your spam to check for any legitimate email that has been 

SOFTWARE

SPAMSIEVE 2.9: A MUST-HAVE SPAM 
FILTER FOR YOUR MAC EMAIL CLIENT
BY GLENN FLEISHMAN

SPAMSIEVE 2.9

mmmmm
PRICE WHEN RATED

$30
COMPANY

C-Command Software
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filtered as noxious, but you can’t do this with iCloud. Much of the spam 
that iCloud gets is simply deleted, and you don’t even know about it.

If you have your own domain name and host your email, then you can 
control how a server-side spam filter works. But I find that when the 
server filters the spam, I forget to check for legitimate emails. I get lots of 
contacts from readers, and it’s annoying to find that many of these 
emails get tossed in the spam folder. And Apple Mail—the email client I 
use—isn’t great at filtering spam.

Years ago I decided that I prefer using software on my Mac to filter spam. 
C-Command Software’s $30 SpamSieve (c-command.com/spamsieve) has 
been around since 2002 and is hands down the best spam filtering soft-
ware for the Mac. Unlike the brute-force filters on servers, SpamSieve learns 
from your email. If you get lots of emails that contain certain words, Spam-
Sieve learns that these are normal, and sends them to your inbox. However, 
if spam gets through, you just select one or more messages and press a 
keyboard shortcut to tell SpamSieve that they are spam; the app learns from 
that too. And it’s incredibly accurate. (On the next page are my SpamSieve 
statistics, since the last time I did a clean install on my Mac, about a year and 
a half ago.)

SpamSieve has a 
whitelist of your 
contacts and people 
you have sent email 
to, a blacklist that 
automatically blocks 
email from senders 
you’ve flagged, and its 
Bayesian analysis 
makes it incredibly 
accurate. I still get 
some spam in my 
inbox, but no more 
than a couple of 
messages a day.

After you install 
SpamSieve—which 
works with Apple Mail, 

THE SPAMSIEVE window is 
a low-key dialog that lets 
you access preferences, a 
log, statistics, and more.

REVIEWS  |  SPAMSIEVE 2.9MACUSER

26

http://www.softgozar.com


Outlook, Airmail, Postbox, 
and many other email 
clients—you don’t ever see 
the app. In fact, there is no 
SpamSieve window, only 
some settings dialogs that 
you can display in Mail, for 
example, by choosing 
Message → SpamSieve → 
Open Window.

SpamSieve launches in 
the background when you 
open your email app, and 
you can control its main 
features—telling the app 
that given messages are 
spam or good email—from 
the keyboard, or from a 
menu. This app works so 
well that, over time, you 
almost forget about it. And 
those two keyboard 
shortcuts—Train As Good 
and Train As Spam—
become second nature.

There’s a lot more: 
detailed logs, optional 
coloring to indicate how 
spammy messages are, 
custom rules, remote 
training, and more. And if you keep a Mac with SpamSieve running, you 
can even keep spam from flooding your iOS device’s inbox.

Filtering spam on my Mac makes my life easier, and SpamSieve is so 
accurate and so easy to use, that it’s one of my 10 essential Mac utilities 
(go.macworld.com/10macessentials). ■

SPAMSIEVE has blocked more 
than 19,000 spam emails, 
with 99.4 percent accuracy.
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MIMEDIA

mmmh
PRICE WHEN RATED

Free (10GB); $85 (500GB) 
annually; $100 (1TB) annually
COMPANY

MiMedia

SEEMS LIKE NEARLY EVERY MONTH, a new cloud storage service 
appears on the scene, arms open in the hopes of cradling your 
precious memories in its loving bosom for a low monthly fee. Having 
tried nearly all of them by this point, I can safely say none have yet 
achieved perfection—although sadly, more than a few have pulled 
bait-and-switch tactics, wound up being acquired by larger compa-
nies, or vanished entirely.

To date, iCloud Photo Library has come closest to my own per-
sonal Holy Grail, mainly because everything is conveniently available 
from all of my devices, and new photos and videos are seamlessly 
synced in the background whenever I’m connected to Wi-Fi. Best of 
all, if I later decide to crop an image or apply a filter, those changes 

CLOUD & SERVICES

 MIMEDIA: NOT QUITE THE PERSONAL   
 CLOUD YOU’VE WANTED, BUT IT’S CLOSE
BY J.R. BOOKWALTER

REVIEWSMACUSER

28

http://www.softgozar.com


are automatically applied everywhere as well.
But there are a couple of downsides: Apple is still fairly miserly when 

it comes to storage, and I still have to manually import photos and 
videos from my wife’s devices, even though she’s part of the same 
iCloud Family Sharing plan. Until Cupertino addresses these shortcom-
ings, the search continues for something better.

MEDIA CLOUD
MiMedia (mimedia.com) doesn’t really address my iCloud pain points, 
but it does get a few things right. The service provides a web app and 
Mac or PC software for uploading photos, videos, music, documents, or 
most any other kind of file up to 2GB in size. The Starter plan is free and 
includes 10GB of storage—
enough to back up your 
iPhone photos, but 
nowhere near enough for 
gigabytes of HD video or 
the average iTunes library.

For those you’ll need to 
pay $8 per month ($85 
annually) for the 500GB 
Basic plan; a 1TB Plus plan 
is also available for $10 per 
month ($100 annually). 
Pricewise, that puts 
MiMedia in the same 
league as heavyweights 
like Dropbox and Google 
Drive, although those 
services are less media-
specific. What sets MiMe-
dia apart is its ability to 
organize and privately 
share uploaded content 
with others.

In addition to importing 
photos and videos from 

MIMEDIA FOR iPHONE offers 
a visually rich user interface 
with a variety of ways to view 
your uploaded photos.
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selected desktop folders, Photos and 
Picasa libraries, or DRM-free songs 
from iTunes, MiMedia can also grab 
content from social networks, Flickr, 
Tumblr, or Dropbox and make them 
part of the same library. One thing 
MiMedia can’t do is crop, edit, or apply 
filters to photos—it’s strictly for storing 
and viewing content at this time.

The OS X uploader is attractive, 
well-designed, and easy to use, with 
queue and upload status windows that 
keep the user informed about what’s 
going on. Unfortunately, it tends to be a 
resource hog: Despite moderate CPU 
usage in Activity Monitor, the Mac app 
caused the fan in my MacBook Pro to 
go full tilt while in use, even when the 
software was sitting idle.

IN ADDITION TO uploading 
media on your desktop, 
MiMedia can also directly 
import from social networks 
and other cloud services.

ON THE MAC, the MiMedia 
uploader software keeps 
tabs on what’s being sent 
to the cloud and how much 
storage remains.
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APPS FOR THAT
In addition to desktop and web apps, MiMedia provides universal iOS and 
Android apps with the same design aesthetic: a sidebar on the iPhone 
filters by specific media types (photos, videos, or music); a consolidated 
bar of options across the app’s home screen on the iPad shows that 
MiMedia takes advantage of the extra pixels. Although MiMedia mobile 
can back up photos and/or videos directly from a device’s Camera Roll, 
music files can only be uploaded from the desktop, and documents aren’t 
currently viewable at all from the mobile apps.

Photos and videos can be marked as Favorites or organized into 
Collections (i.e., albums) just by flicking a thumbnail toward the desired 
option. There’s also MiDrive, a private social network where invited 
members can share content and text-chat with each other. Paid sub-
scriber media shared with Starter users doesn’t count against free 
storage, so it’s a great way for families to share without multiple paid 
accounts.

After spending a weekend uploading Photos and iTunes libraries  
on the desktop, I toggled on automatic uploads from my iPhone 6s  
Plus to see how the service handled potential duplicates. MiMedia is 
unique in that users can choose to upload only from specific albums—a 

SHARING CONTENT FROM 
MiMedia is just a gesture 
away, which can also be 
used to add media to a 
collection or MiDrive, a built-
in private social network for 
family and friends.
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convenient option other services would be wise to adopt.
Unfortunately, MiMedia forces iCloud Photo Library images to first 

download as generically-named FullRenderImage.jpg files prior to 
uploading, resulting in duplicates of the same photos in the cloud. The 
only workaround was to turn off automatic uploads on my devices and 
use the desktop uploader instead.

BOTTOM LINE
I really like where MiMedia is headed, and how content is organized and 
shared. The software lacks the ability to edit photos and the current 
pricing isn’t particularly competitive, but MiMedia is otherwise worth a 
look for those seeking a user-friendly, media-centric cloud. ■
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DAYLIGHT 6

mmmm
PRICE WHEN RATED

$300 per user; hosted services 
starting at $29 per user per 
month
COMPANY

Marketcircle

DAYLITE, MARKETCIRCLE’S CONTACT, schedule, project, and sales 
management program, is designed to help you stay on top of every-
thing your business is doing. It’s purpose is to keep you focused on 
two objectives: Tracking new business opportunities and following 
through on what you promise to current and potential customers.

Daylite can be used by organizations with users who need access 
to company data on all their devices no matter where they are. When 
I last reviewed the app, Marketcircle offered a self-hosted option: you 
set up your own server in your office and managed it like any other 
server, or it recommended you use Macminicolo’s colocation services 
(macminicolo.net), which is kind of like self-hosting with a better 
backbone—Macminicolo offers stellar, Mac-based colocation 

BUSINESS SOFTWARE

DAYLITE 6: EXCELLENT FOR CREATING, 
MANAGING, AND KEEPING BUSINESS 
OPPORTUNITIES
BY JEFFERY BATTERSBY
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services. Marketcircle still offers these two options for $300 per user, 
but now also offers a cloud-based hosted service option starting at $29 
per user per month.

For the purposes of this review I used Marketcircle’s cloud-based 
service with initial data that was created by Marketcircle. I found it to be 
fast and quick to sync across all my devices (as long as I had access to 
the Internet)—overall, it worked quite well.

I have to laugh a little here, as one of the things I complained about in 
my last review remains an issue in the current version of Daylite. In short, 
all the video tutorials on Marketcircle’s website are about Daylite 5. 
Fortunately there’s not a huge UI difference between versions 5 and 6, 
but they are different enough that new Daylite users might find them-
selves looking for things that don’t exist in the same exact locations as 
they are in the videos. I recommend clicking the Help menu and down-
loading the User Guide, which is up to date. (Although, the document’s 
footers all reference Daylite 5!) This documentation issue is also miti-

REVIEWS  |  DAYLIGHT 6MACUSER
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gated somewhat by Daylite’s new First Run Tips feature, which displays 
context-specific information related to Daylite’s features.

EVERYTHING IN ONE PLACE
The main idea behind Daylite is to centralize every aspect of your 
business in a single location and allow everyone involved in a project to 
update information. Daylite’s sidebar provides one-click access to the 
app’s Calendar, Contact, Objectives, Tasks, Notes & Email, Forms, and 
Groups. Because this is a tool designed for group work, most of the 
items in the sidebar allow you to quickly filter the information you see 
either by using the search tool or by selecting a specific item.

For example, if you look at Daylite’s calendar you’ll see your personal 
calendar, a calendar for all users and resources, and individual calendars 
for each of your team members. This allows you to very quickly see what’s 
going on in your organization and make day-to-day assessments of what’s 
on tap.

Since this is a collaboration tool, it’s important to have a way to 
manage what users can see and who has access to what information. 
Daylite offers (within the app’s preferences) tools for managing access to 
any Daylite object. Using the permissions tool you can create permis-
sions presets that provide a defined set of permissions for specific users 
and groups and then apply those permissions to the objects you want. 
My only complaint about the permissions tool is that it requires that you 
restart Daylite for every new permissions change you make.

DAYLITE’S new First Run Tips.
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MAIL MANAGEMENT
One of my favorite Daylite features is 
the app’s Mail Assistant. When you 
install Daylite a Mail app extension gets 
installed that links Apple’s Mail app to 
Daylite. Once installed a new sidebar 
appears in the Mail app allowing you to 
quickly link any email message to an 
existing Daylite contact, objective, task, 
and apply viewing permissions. When 
you do this the email message you’ve 
linked appears within Daylite.

Linked email messages become part 
of your Daylite database, where you can make changes to a document, 
update permissions, and link them to other objects. This makes no 
changes to the original email message.

IMPORT(ANT) FIX NOT IN
I said earlier that there was one thing that wasn’t fixed since my previous 
review. I confess now that I was only half accurate. Both of the things I 
complained about in my last review still haven’t been fixed in Daylite 6, 
the second item being the introduction and duplication of contacts when 
importing Calendar app data.

In short, if you import calendar data and you have calendar items with 
contact information embedded in them, you will end up with a Daylite 
contact record for every one of those events. The upside is that it’s 
unlikely you’ll import calendar data more than once. But seriously, folks, 
you’ve had some time to work this out. Hopefully it will be resolved by 
the time Daylite 7 is released. Or sooner! (Ideally.)

BOTTOM LINE
Unfixed issues aside, Daylite 6 remains an excellent tool for creating, 
managing, and tracking business and business opportunities. Its Mail 
Assistant streamlines linking correspondence to Daylite clients and 
projects, and Marketcircle’s cloud-based hosted service offers “always-on” 
access to servers that you don’t have to manage. If you need centralized 
client management, you’ll be hard put to find a better tool than Daylite. ■

REVIEWS  |  DAYLIGHT 6MACUSER
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What We’re 
Raving About 
This MonthHot Stuff
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LEEF iACCESS
Leef’s $50 iAccess (leefco.com) is an expandable storage device for the 

iPhone, iPad, or iPod touch, and it’s a nifty one at that. This tiny dongle plugs 

in to your devices Lightning port, and at the base of the white, plastic unit is a 

slot for a microSD card up to 128GB. Weighing only six grams, iAccess is 

angled in the shape of a hook, which gives the reader a low profile by 

extending only 16.6mm from the device. The remaining 40.5mm wraps out of 

sight around back, leaving a 5mm 

gap from the device—enough 

clearance for the bulkiest 

of cases. It’s a pretty 

ingenious design that 

solves a big problem 

with earlier card 

readers that stuck out 

like a sore thumb. 

—J.R. BOOKWALTER
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GUITAR HERO LIVE FOR IOS AND APPLE TV 
Guitar Hero Live (guitarhero.com) reboots Activision’s classic franchise after a five-

year hiatus with a new guitar, fresh aesthetic, and different ways to play. It works 

across consoles and the iPhone and iPad, as well, thanks to a mobile version—avail-

able for $100 with the 

guitar—that lets you use 

the same full-sized control-

ler while the game runs on 

your iOS device. You can 

also fling it over to your TV 

using AirPlay on an Apple 

TV, or a Lightning Digital 

AV Adapter—and it’s now 

natively available for the 

new Apple TV too. Also, 

there’s a happy surprise 

with this new rendition: 

You can still play without 

the guitar on iOS in a 

tap-centric mode, making 

this a Guitar Hero that’s 

ideal for home or on the 

go. —ANDREW HAYWARD

MACUSER
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GRIFFIN TECHNOLOGY’S BREAKSAFE  
MAGNETIC USB-C POWER CABLE
Apple touts its 12-inch MacBook as “the future of the notebook.” Curiously, it has 

a very retro power adapter that lacks a breakaway MagSafe power connector, 

like the one found in the MacBook Air or MacBook Pro. So if you’re sitting in  

a coffee shop with the MacBook plugged in to a power outlet and someone trips 

over the power cable, there’s a very good chance your MacBook will go flying off 

your table. Fortunately, Griffin Technology just released a product to make sure 

that never happens. The $40 BreakSafe Magnetic USB-C Power Cable (griffin-

technology.com) is a six-foot power cable that has a two-piece connector that 

plugs into the MacBook. The two pieces are connected magnetically, and if you 

yank on the cable, the connector breaks apart. No more flying MacBook. —ROMAN 

LOYOLA
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iOS CENTRAL The Latest on the iPhone, iPad, 
iPod Touch, and App Store

Tested: Apple’s Magnetic Charging 
Dock, and 4 other Nightstand-
mode-ready Apple Watch stands
These stands turn your Watch into the perfect bedside companion.

BY SARAH JACOBSSON PUREWAL
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W hen Apple introduced Nightstand mode in 
watchOS2, most of the stands in our recent round-
up became obsolete—well, obsolete for those of 
you who want to take advantage of this new 

convenient charging mode. Nightstand mode only activates when 
the Apple Watch is oriented horizontally (though it doesn’t have to 
be sitting at 90 degrees—45 will work just fine), and many stands 
on the market only let you orient your Watch vertically.

AND THEN, A COUPLE of months 
after watchOS2 and Nightstand mode 
debuted, Apple also dropped its very 
own Nightstand-mode-ready $79 
charging dock. But because Apple 
shouldn’t be your only choice for 

Apple Watch accessories, we tried 
out the Apple Watch Magnetic 
Charging Dock and four other 
Nightstand-mode-ready Apple Watch 
stands to see what your best bedside 
option is.

APPLE’S APPLE 
WATCH Magnetic 
Charging Dock.
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APPLE’S APPLE WATCH 
MAGNETIC CHARGING DOCK
We’ll start with Apple. The $79 Apple 
Watch Magnetic Charging Dock (go.
macworld.com/awmagdock) is the 
only official charging dock on the 
market. This dock is hardly a dock at 
all—it has a coaster-like design, 
which is very similar to the Blue-
Lounge Kosta (go.macworld.com/
kosta), and a built-in charging puck 
that can lie flat or pop up to support 
Nightstand mode. It comes in just 
one color: White, with a dove gray 
base and silver hardware.

The Magnetic Charging Dock isn’t 
much to look at—and I don’t mean 
that in a “wow, it’s so minimalist” kind 
of way. It’s a flat, white disc that 
measures just over four inches in 
diameter. It’s slightly raised in the 
center, where the charging puck lives 

inside a polished silver metal frame, 
and tapers off toward the edges. The 
top of the dock is covered in soft 
white rubbery material, while the 
underside sports dove gray suede. 
The dock is relatively heavy, so it 
won’t move or fall off your bedside 
table when you snatch your Watch 
off the puck in the morning.

The puck in the center of the 
Magnetic Charging Dock is plastic, but 
its sides and back are encased in 
metal. The puck is on a sturdy hinge, 
and pops up to work with Nightstand 
mode on the Watch. When you use this 
dock in Nightstand mode, your Watch 
and its band sit securely on the soft 
white rubbery material of the dock. But 
when you use this dock in non-Night-
stand mode, the buckle of your Watch’s 
band (and possibly more, depending 
on the length) falls off the coaster.

iOS CENTRAL APPLE WATCH STANDS
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The Magnetic Charging Dock is 
simple and well-made, but it’s just not 
very attractive. There’s a lip of 
material around the edge of the dock 
where the upper white material and 
the lower gray material meet, which 
makes the dock look unfinished. 
Design-wise, the dock looks so much 
like a coaster that I accidentally put 
my drink down on it a few times. And 
while the upper material feels soft 
and luxurious, it’s also white and, I 
imagine, difficult to clean.

My favorite thing about this dock is 
that it comes with an extra-long 
Lightning cable that plugs into the 
back. This cuts down on the amount of 
cords you need to organize and travel 
with, because the Lightning cable can 
also charge your iPhone when it’s not 
charging your Watch. A two-meter 
Lightning cable costs $29 on Apple’s 
website, so that makes the dock a little 
more affordable. But you’re still paying 
$50 for a dock that’s as aesthetically 
impressive as the $15 BlueLounge 
Kosta (which comes in three easier-to-
keep-clean colors).

NATIVE UNION DOCK  
FOR APPLE WATCH
If you’re looking for minimalism 
worthy of an Apple product, the $60 
Native Union Dock for Apple Watch 
(nativeunion.com/dock-for-apple-
watch) is beautiful and versatile. This 
dock sports a simple pedestal-like 

design and lets you display your 
Watch in both the traditional display 
mode and Nightstand mode. The 
$60 dock comes in one color—slate 
gray with a silver aluminum cylinder—
but Native Union also sells a $120 
luxury version, which features a solid 
marble base in black (with a silver 
aluminum cylinder) and white (with a 
gold aluminum cylinder).

This dock comes in two parts: A 
square, weighted base covered in 
soft gray silicone, and a spinning 
silver aluminum cylinder, which 
houses the charging puck and cord. 
Native Union’s logo is neatly 

NATIVE UNION DOCK for 
Apple Watch
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engraved on the back of the gray 
silicone base. The two pieces are 
held together with strong magnets, 
but the cylinder is on a rotor, which 
allows it to rotate 360 degrees.

The cylinder has a circular cutout 
for the charging puck, as well as a 
clever hidden cord management 
system inside it. To place your puck 
in the dock, you’ll need to separate 
the cylinder from its base and put 
your puck in the circular cutout. The 
cutout isn’t deep enough to conceal 
the puck’s edges, so you’ll see quite 
a bit of your charging puck sticking 
out—it’s not incredibly ugly, but it 
does take away from the dock’s 
sleek minimalism. The cord from 
your puck travels down, into the 
cylinder, where you can wrap it 
around the base of the cylinder a 

couple of times. It then snakes out 
the back, opposite the charging 
puck.

Once the puck and cable are in 
place, you can put the cylinder back 
in the base. The cord awkwardly 
sticks out of the cylinder—in order for 
it to continue to rotate 360 degrees, 
the cord can’t be hidden through the 
base of the dock.

The Native Union Dock is very 
attractive, but it does have its down-
sides. Once you place the charging 
puck and cable in the dock, it loses 
some of its sexiness. Also, the silicone 
on the base is a dust magnet. But this 
is still an excellent Nightstand-ready 
Watch dock—it’s prettier (and 
cheaper) than Apple’s version, it 
supports both Nightstand and regular 
modes, and it’s very versatile.

iOS CENTRAL APPLE WATCH STANDS
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Watch

http://www.softgozar.com


45

PAD & QUILL TIMBER NIGHT-
STAND FOR APPLE WATCH
Pad & Quill’s $90 Timber Nightstand 
(go.macworld.com/thetimber) func-
tions as both a dock and a display 
tray for your bedside table. This 
hardwood stand has a relatively large 
footprint (the base measures 4.75 
inches long by 6.5 inches wide), 
because it includes a grooved tray 
for storing extra Apple Watch bands. 
The handmade Timber Nightstand 
comes in three finishes: American 
Cherry, Exotic Sapele, and Premium 
American Walnut, which costs an 
additional $30.

The Timber Nightstand can only 
display your Watch in Nightstand 
mode. At the front of the stand, 
there’s a small, square piece of wood 
where your Watch will sit. This piece 
of wood has a circular cutout for the 
charging puck, as well as a hole large 
enough for a pen to fit through (to 
make removing the charging puck 
easier). To put the puck into the 
Timber, you thread the puck’s cable 
through a USB-plug-sized square 
hole at the bottom of the cutout. The 
cable runs through a groove under-
neath the stand and out the back.

Once it’s positioned inside the 
Timber, the puck does not lie com-
pletely flush with the wood. This didn’t 
bother me too much, however, because 

the edges of the puck only overlap by a 
millimeter at most. Your Watch rests on 
a small strip of leather branded with 
Pad & Quill’s logo, and the band circles 
behind the 
charging puck.

Behind the 
Watch, there’s a 
groove that’s 
perfectly sized to 
fit an extra band. 
The groove does 
not have a lip on 
either side, so it’s 
not ideal for 
jewelry or 
change—for a 
true “catchall” 
style Watch stand, you can pick up 
Pad & Quill’s $100 Timber Catchall. 
The Timber Nightstand looks great 
with an additional band displayed, 
but if you have more than one extra 
band it will start to look messy.

The Timber Nightstand is an attrac-
tive wooden stand, but its design 
won’t appeal to everyone. To me, it’s 
reminiscent of wooden catchall 
dishes my father used to have by his 
bed—it looks a little too masculine 
and old-fashioned for my taste. But 
it’s a sturdy stand—it has five small 
rubber feet on the bottom for extra 
grippiness—and it does make a 
lovely display tray for your bands.

TO ME, IT’S 
REMINISCENT OF 
WOODEN CATCHALL 
DISHES MY FATHER 
USED TO HAVE BY 
HIS BED—IT LOOKS 
A LITTLE TOO 
MASCULINE AND 
OLD-FASHIONED 
FOR MY TASTE. 
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SCHUTTENWORKS RIPPLE 
FOR APPLE WATCH
SchuttenWorks’ $54 Ripple for Apple 
Watch (go.macworld.com/theripple) is 
a very simple Nightstand-only Apple 
Watch dock with a unique magnetic 
closure that cleverly hides the Watch’s 
charging cable. The wooden Ripple 
comes in multiple finishes, including 
bamboo, walnut, and mahogany, and 
fits both the plastic and the metal 
charging pucks.

At first glance, the Ripple looks like 
a single, solid piece of carved wood. 
The front has a precision-cut hole that 
fits the charging puck (when you 
order your Ripple you can specify if 
you’d like it cut for the plastic or the 
metal charging puck), and a small 
rounded ledge where your Watch’s 
face rests. The back of the Ripple has 
a gently-sloping ledge for your closed 

strap, as well as a small hole for the 
charging cable to exit. SchuttenWorks’ 
logo is engraved on the right side of 
the dock.

But while the Ripple looks like a 
single, solid piece of carved wood, 
it’s not. It actually comes apart—right 
down the middle, though the pieces 
fit together so perfectly that you can 
barely see the seam. Inside the 
Ripple, there are magnets, dowels 
(for fitting the pieces perfectly back 
together), and a groove that hides 
the charging cable. To install the 
charging puck, simply separate the 
two pieces and place the puck and 
cable in one side, and then snap the 
two pieces back together. Schutten-
Works isn’t lying when it says the 
cutout for the charging puck is 
precision-cut—the puck fits perfectly 
into the hole and lies completely 

iOS CENTRAL APPLE WATCH STANDS
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flush with the wood around it.
The Ripple isn’t very heavy—so to 

keep it from sliding around on your 
bedside table (or falling off), Schut-
tenWorks has attached two strips of 
advanced micro suction tape to its 
underside. This tape isn’t particularly 
sticky when you touch it, but it 
creates friction between the stand 
and any surface, so the stand won’t 
slide or fall off, and you can reposi-
tion the stand without worrying about 
residue. Micro suction tape will not 
work on a vertical surface. The inside 
of the charging puck cutout also has 
micro suction tape to keep every-
thing perfectly in place.

The Ripple is simple and very, very 
well-made. Like the Timber Night-
stand, its wooden design might not 
appeal to everyone, but it’s beauti-
fully crafted. The Ripple is also the 
smallest stand in our roundup, with a 

footprint of just 1.5 inches wide and 3 
inches long.

TWELVE SOUTH FORTÉ FOR 
APPLE WATCH
The $60 Twelve South Forté (go.
macworld.com/forte) is a gorgeous 
metal and leather Apple Watch stand 
that supports both Nightstand mode 
and the traditional Apple Watch 
display mode. The Forté features a 
black leather base, shiny chrome 
accents, and a design that cleverly 
hides the charging cable. Unlike the 
other stands in our roundup, the 
Forté holds your Watch at a 
45-degree angle, even in Nightstand 
mode—so this could be a good 
solution for people with tall mat-
tresses and low tables. The Forté 
comes in just one color combo, black 
and silver.

The Forté has a large, flat base 

TWELVE SOUTH FORTÉ 
for Apple Watch
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that measures approximately 3.25 
inches wide by 3.75 inches long. The 
base has chrome edges and is 
covered in soft black leather. The 
base is weighted—this stand won’t 
move too much, despite the fact that 
its bottom sports black foam instead 
of a grippier substance. At the back 
of the base, a single silver tube 
extends, curving once, and culminat­
ing in a circular charging puck holder. 
The charging puck holder is lined in 
black rubber and has a removable 
silver frame that hides the sharp 
edges and makes the stand look 
more polished. This frame is made of 
plastic, though it’s painted in chrome.

To put the charging puck in the 
Forté, all you have to do is remove 
the silver frame and place the puck 
into the holder. The cord snakes down 
the silver tube, tucking inside it until 
it reaches the bottom, where it simply 
exits the back of the stand. It’s one of 

the easiest charging puck in stall­
ations of any stand I’ve used, and it 
still looks excellent. Place the frame 
over the puck once you have the 
cord in place, and you’re ready to go.

Your Watch can sit on the stand in 
regular display mode—in which case 
the band will be able to hang through 
the curve in the silver tube—or in 
Nightstand mode. Because my 
bedside table is at the same height 
as my mattress, I found this stand to 
be a bit difficult to use in Nightstand 
mode—the arm is tall (approximately 
3.35 inches tall), and so it was a little 
difficult to see the Watch at a 
45­degree angle.

The Forté may not be as minimalist 
or rustic as some of the other stands 
in our roundup, but it has a very 
polished, luxurious look to it. The 
chrome and sumptuous leather look 
particularly appropriate with the 
higher­end Apple Watches. ■
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Alternatives 
to Apple’s 
Podcasts 
iOS app
Here are a few iOS apps that 
let you listen to podcasts and 
manage them much more 
efficiently than Apple’s solution.

BY KIRK MCELHEARN
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Apple’s Podcasts app can be compli-
cated and confusing. Designed to 
sync with iTunes, the app has a 
befuddling approach to organizing 
podcasts, with organization by 
podcast, playlist, and “station.” 
Syncing is often unreliable, so if you 
do manage your podcasts in iTunes, 
and want to listen on your iOS 
device, you’re likely to have differ-
ences between the two.

Unless you listen to podcasts often 
on your Mac, it’s probably best to not 
even use iTunes for this type of media. 
I’ve given up on iTunes for podcasts, 
and listen to them on my iPhone. I 
sometimes stream them to my Apple 
TV in the living room, or to an AirPlay 
speaker. Or I use Rogue Amoeba’s 
Airfoil Speakers (go.macworld.com/
airfoil) to turn my Mac into an AirPlay 
receiver and listen to them there.

Here are a few iOS apps that let 
you listen to podcasts and manage 
them much more efficiently than 
Apple’s solution.

THE LATE INSTACAST
Let me start by briefly lamenting the 
demise of Instacast, which was retired 
in June. It offered both an OS X and 
iOS app, which, like iTunes, synced 
your podcasts and settings, allowing 
you to easily switch from one device 
to another. Instacast will be missed, 
especially by those who want to save 
episodes of their favorite podcasts.

This is actually the one weakness 
of managing podcasts on an iOS 
device. While apps can save epi-
sodes, you won’t have them on your 
Mac to archive them. If this is the 
case, I’d recommend you download 
those podcasts to iTunes, so you can 
keep them in your library.

OVERCAST
The free (with optional patronage) 
Overcast (overcast.fm) lets you 
download or stream episodes. You set 
up playlists and choose how many 
episodes to keep and download. 
Overcast makes it easy to manage 

I f you’re a podcast fan, you have many ways to listen to your 
favorite shows. You can download them to iTunes and listen to 
them on your Mac. You can sync them from iTunes to your iOS 

device, and listen to them with Apple’s Podcasts app. You can 
subscribe to them on the Podcasts app, and download them only 
to your iOS device. Or you can use one of a number of third-party 
apps on iOS.
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podcasts and episodes. You can 
search Overcast’s directory, and if you 
don’t find the podcast you want, you 
can also manually add a URL.

There is no desktop equivalent for 
Overcast, but the app does offer a 
web-based interface at overcast.fm. 
While you can’t download podcasts 
to your Mac, you can stream from 
this website. All your subscriptions 
and episodes sync, so it’s easy to 
use this player on the desktop, or on 

another iOS device.
Overcast’s killer feature, for me, is 

its Smart Speed feature, “which 
dynamically shortens silences in talk 
shows,” as well as speeding up the 
speakers. Since this is a dynamic 
setting, it’s not absolute, but I listen 
to most of my podcasts at about 1.4x 
to 1.5x. You can adjust this setting on 
the fly, or for each podcast, so you 
can turn it off for music podcasts, and 
turn it on for talk.

iOS CENTRAL PODCAST APPS

OVERCAST’S Smart Speed shortens podcasts 
but doesn’t make them sound like Alvin and the 
Chipmunks

CASTRO’S interface makes it hard to read podcast 
descriptions, especially in bright light.
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Overcast also offers an Apple Watch 
app, if you use that wrist computer.

CASTRO
Like Overcast, Castro (go.macworld.
com/castro) has recently gone free 
with patronage. It’s an attractive app, 
for the most part, but its usability is 
marred by some tiny fonts in episode 
descriptions, and by blurry, colored 
backgrounds with translucency when 
viewing a podcast.

The app has a number of settings 
that let you choose how to refresh or 
download episodes, alter the play-
back speed (which can be set per 
podcast), how much storage to use 
and more. However, it takes a while 
to get used to the essentially ges-
ture-based interface of the app but 
it’s fast and responsive, and once 
you get the hang of it, it’s quite 
intuitive. Be prepared to spend some 
time fiddling with it before you get 
your settings right.

DOWNCAST
The $3 Downcast (go.macworld.com/
downcast) should come with a 
magnifying glass. It’s full of finicky 
features and settings, but it’s very 
hard to read episode descriptions, 
especially on the go. Its play screen 
contains a surfeit of controllers, 
making it look a bit like a control 
panel for a nuclear power plant. You 
can tweak a number of settings, 

adjusting how episodes are 
refreshed, downloaded, and stored, 
set a sleep timer, change playback 
speed (up to a ludicrous 3x), and 
much more.

Downcast lets you sync your 
settings and subscriptions via iCloud, 
so if you listen on more than one iOS 
device, you’ll find this useful. How-
ever, it’s utilitarian at best, and, while it 
lets you download and stream 
podcasts, it doesn’t make the process 
enjoyable. Downcast does have an 
OS X app and can sync with the iOS 
app (go.macworld.com/downcastosx).

DOWNCAST has 
lots of controls.
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iCATCHER!
The $3 iCatcher (go.macworld.com/
icatcher) combines a lot of the 
features in Downcast with a more 
polished interface. It’s got dozens of 
settings, but it’s a lot easier to 
navigate. Tabs on the bottom of the 
window take you to podcasts, 
downloads, playlists, help, and 
settings. When you tap and hold an 
episode, a pop-up displays (not 
exactly 3D Touch; there’s no haptic 
feedback) showing a description of 
the episode.

This app also syncs your settings 
via iCloud, so you can use it on 
multiple devices. It offers an Apple 
Watch app, supports split screen on 
recent iPads, and much more. While 
it’s a bit finicky, it’s well designed.

There are lots of options for 
listening to podcasts on iOS devices. 
Whether you choose the default 
Podcasts app or others, there are 
plenty of apps you can try out. Only 
Overcast offers an option to listen to 

iOS CENTRAL PODCAST APPS

READ SHOW NOTES easily in these pop-ups.

podcasts on the desktop, via its 
website—that and its Smart Speed 
feature make it my choice. ■
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Why the  
iPhone 7 could 
(and should!)  
be waterproof
Preventing water damage not 
only keeps customers happy, 
but benefits Apple itself.

BY DAN MOREN

http://www.softgozar.com


Next year, if the pattern holds true, 
we’ll see an iPhone 7, again with that 
faster processor and better camera. 
But a new number generally signals 
a new flagship feature: the iPhone 4 
had the Retina display; the iPhone 5 
had a bigger display, LTE, and a 
Lightning port; the iPhone 6 had an 
even larger display and Apple Pay. 

So what’s the big selling point for 
the iPhone 7 going to be?

Here’s one possibility: water­
proofing.

WATERPROOF IN THE 
PUDDING
Waterproofing electronic devices is 
hardly impossible. Aftermarket 

By this point, we know the pattern pretty well. Every year 
there’s a new iPhone, with a faster processor, better 
camera, and a few other new tricks up its sleeve. Every 
other year there’s a new form factor, with a (usually) 

lighter and thinner case, and some more significant changes.

SONY ACTUALLY HAD 
to tell people not 
to use its Xperia Z3 
underwater. Wonder 
where folks would 
have gotten that idea?
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waterproof cases exist for cameras 
and phones, though they’re bulky 
and cumbersome—they’re fine if you 
want to go diving and take some 
pictures, but not so great to leave on 
all the time.

Several vendors, including Sam-
sung, have developed waterproof 
phones (go.macworld.com/bestwa-
terproofphones), which range from 
water-repellent coatings to fully 
submersible devices that can with-
stand a certain amount of time 
underwater. (Challenges still remain, 
such as using the touchscreen while 
submersed.)

Apple too has—ahem—dipped its 
toe into waterproofing. The Apple 
Watch is water-resistant and has an 
“ingress protection” rating of IPX7 
(go.macworld.com/ingressprotec 
tion), which means it can be 

immersed in up to 1 meter of water 
for 30 minutes. Tim Cook has said 
that he showers with his watch on, 
and Developer Craig Hockenberry 
did a pretty thorough analysis (go.
macworld.com/awwaterworkouts) of 
the Apple Watch’s water resistance 
and found that it lives up to its claims.

But that makes sense for a device 
that you’re going to wear on your 
person at all times. It’s a little less 
critical in the iPhone—but that 
doesn’t mean it wouldn’t be useful.

LIQUID DAMAGES
Water and electric devices generally 
don’t mix, as we know. And now that 
we’re all carrying our smartphones 
everywhere, the chances of dropping 
one in a puddle, a pool, or even the 
toilet have increased drastically. 
Odds are it’ll happen to all of us at 

iOS CENTRAL WATERPROOF iPHONE

RAISE YOUR HAND IF 
you’ve heard that 
“plunk” sound and felt 
your heart just drop.
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some point or another.
And water damage is a pain, 

because it’s not covered by Apple’s 
warranty. That’s great for Apple if you 
wind up buying a new phone, but not 
so great if you get annoyed and decide 
to go in a different direction—buying a 
cheaper Android phone until you can 
afford a new iPhone, for example.

It’s also not great for Apple 
because when you break your 
phone, through whatever means, and 
get a new one, Apple can take apart 
the old phone and either refurbish it, 
or use parts for repairs. While it’s 
possible that Apple can reuse at 
least parts of some water damaged 
phones, there are probably also a lot 
of parts that aren’t worth salvaging, 
depending on the level of damage.

THE SURPRISINGLY 
WATERPROOF iPHONE 6S
As it turns out, Apple’s already 
made strides in protecting the 
iPhone from water damage. Anec-
dotal reports have suggested that 
accidentally dropping the iPhone 6s 
in liquid didn’t result in the expected 
damage, so iFixit dug deeper and 
concluded that Apple has already 
taken steps to improve the iPhone’s 
water resistance.

For one thing, a new gasket runs 
around the inside of the case to help 
keep water out. Moreover, all of the 
connectors on the logic board are 

sealed with silicone, to prevent them 
from shorting out. Apple even filed a 
patent on that technique early last year.

There are a few places where 
further work is needed: the power 
and volume buttons, for example, 
and the speakers and headphone 
jack. But surprise! 
Apple’s filed a 
patent on water-
proof buttons 
and, more 
recently, on 
waterproof ports.

This also might 
be why Apple 
has considered 
the radical 
decision of 
dropping the 
headphone jack 
(go.macworld.
com/hponejack 
rumor) from the next iPhone. After all, 
one less port means one less thing 
Apple has to worry about waterproof-
ing. (I’m not convinced that’s worth 
the trade-offs, but it certainly might 
go into the calculus.)

The touchscreen remains the 
single biggest problem for having a 
phone that actually works with water, 
and it might not be one that Apple 
solves right away. But people will 
probably be mostly satisfied if their 
iPhones are protected against those 
accidental pool drops.

THE TOUCHSCREEN 
REMAINS THE 
SINGLE BIGGEST 
PROBLEM FOR 
HAVING A PHONE 
THAT ACTUALLY 
WORKS WITH 
WATER, AND IT 
MIGHT NOT BE ONE 
THAT APPLE SOLVES 
RIGHT AWAY. 
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WATER, WATER EVERYWHERE
As water-resistant as the iPhone 6s 
might be, Apple doesn’t mention it 
anywhere. For good reason too: 
There’s no need to encourage people 
to test out the water-resistance of 
their phones, nor to incur any false 
advertising claims when water 
damage actually does occur. Better to 
underpromise and overdeliver.

But given all the time and energy 
that Apple’s invested into water-

proofing the iPhone, it seems clear 
that it has aspirations in that direc-
tion. So don’t be surprised when next 
year’s iPhone ad features droplets of 
water running over the surface of the 
phone, or the keynote highlights an 
Apple executive’s snorkeling trip to 
Hawaii, complete with underwater 
photos.

Me, I’m holding out for Phil Schiller 
in a dunk tank. A man can dream, 
right? ■
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CORTANA FOR iPHONE: SIRI  
HAS LITTLE TO FEAR FROM 
MICROSOFT’S VIRTUAL ASSISTANT
BY J.R. BOOKWALTER

VIRTUAL PERSONAL ASSISTANTS are ubiquitous across all three 
major smartphone platforms: iOS has Siri, Android has Google Now, 
and Windows Phone has Cortana. But while there’s 
some overlap, only Apple has all three now that the 
good folks in Redmond have ported their Windows-
only service to both iPhone and Android.

While there are subtle differences, all of them 
essentially do the same thing: Make it easier to get 
information and find stuff with your voice. A hybrid 
of Siri and Google Now’s card-based concept, 
Cortana 1.3 (go.macworld.com/cortana13) 
interesting tricks up her sleeve, but is there 
any compelling reason to choose this app 
over what’s already baked into iOS?

I spent a week with Microsoft’s newest 
iPhone app in an effort to definitively 
answer this question, and the answer 
appears to be no, at least for now—
Cortana is simply too limited in its 
current incarnation, although PC 
users will benefit since the service is 
also on Windows 10.

REVIEWSiOS CENTRAL
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HEY, CORTANA
The youngest of the three intelligent personal 
assistants, Cortana is derived from a popular 
character of the same name in Microsoft’s 
Halo video game franchise. Although its roots 
as an internal project for the company’s 
Speech division date back to 2009, Cortana’s 
first appearance came at the annual Build 
developer conference in mid-2014, and 
wasn’t available to the public until 2015.

Before I launch into a breakdown of what 
Cortana does, it’s important to note what it 
can’t do: Namely, perform the same kind of 
device-wide magic Siri can with a press of the 
home button. That’s because Cortana is just 
another app, and can only access what 
Apple’s APIs allow—mostly push notifications 
for reminders right now.

Since this is a shortcoming Microsoft is 
unlikely to circumvent any time soon, the next 
best way to initiate Cortana would be from a 
Notification Center widget—but sadly, there’s 
none to be found here. Cortana can’t even be 
summoned from other Microsoft apps like 
Outlook, and travel directions open in a 
mobilized web version of Bing, rather than the 
native app. (Yuck.)

On Windows, users can summon Cortana 
by saying “Hey Cortana,” but—you guessed it—the iPhone version can’t 
perform this hands-free trick. (It’s available for Android users outside the 
United States, but only from the home screen or when Cortana is open.) 
Last but not least, Cortana can’t be used to open other apps or fiddle 
with iOS system settings like it can on Windows.

MAKE NOTE OF THIS
These limitations aside, Cortana does offer one unique feature: Note-
book, a cloud-based hub where personal information is stored and 
referenced. Notebook features 15 different categories, ranging from 

iOS CENTRAL

CORTANA ENCOURAGES you to 
“ask me anything”—but only 
when the app is open.
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Finance to Movies & TV to Travel. This is also where users toggle off 
notifications from topics they have no interest in (in my case, Sports).

A few categories require a bit of customization for best results, 
although Cortana doesn’t do a particularly good job of letting users 
know this. The Eat & Drink category, for example, includes a variety of 
personal preferences such as Ambience, Cuisine, and Distance to help 
cater search results to your particular taste.

Cortana can also track packages en route to your home or office, 
although these numbers must be entered into Notebook manually, 
kind of defeating the purpose of a personal assistant. My first attempt 
failed with a “not a valid tracking ID” error, despite copying and pasting 
a tracking number straight from the FedEx website.

Finally, there’s About Me, where you can view favorite places 
Cortana has remembered, or change how she refers to you (a clever 
nickname like J.R., perhaps). There are additional options for managing 
your profile under Settings, but this simply opens a web link to Bing, 
the Microsoft search service at the heart of Cortana.

MORE OFTEN THAN not, 
Cortana silently responds 
with cards pulled from Bing 
search results (left), rather 
than the witty repartee of Siri.

BE SURE TO VISIT each 
of Cortana’s Notebook 
categories (right), because 
many of them have settings 
to help customize the 
experience.
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CORTANA VS. SIRI
When launched, Cortana 
pulls up cards for the 
weather at your current 
location, as well as quick 
previews of relevant local 
and national news. 
Tapping an item opens 
the complete article using 
the in-app browser; from 
there, you can also send 
directly to Safari. You’ll 
want to get used to 
looking at these cards, 
because a lot of the time, 
Cortana is little more than 
a silent shortcut for web 
searches.

One big advantage 
over Siri is that you can 
type questions as well as 
speak them, using the 
Ask Me Anything field at 
the bottom of the screen. 
(If you’ve ever felt silly 
speaking to your iPhone, this one’s for you.) Tapping the blue micro-
phone icon at right initiates Siri-style voice queries instead. In my tests, 
Cortana was fast and exceptionally accurate at voice recognition, but 
limited to a single female voice in English or Chinese; she also isn’t 
nearly as sassy or fun to use as Siri, who currently speaks nearly 30 
different languages.

To put Cortana to the test, I fed both assistants identical questions and 
compared responses. Questions like “How old are you?” produced 
similarly cheeky answers: “I’ve been around longer than ‘crowdsourcing’ 
has been in the dictionary” (Cortana) and “I am not allowed to answer 
that question” (Siri). But a lurid “talk dirty to me” request returned a blunt 
“No thanks” from Cortana, while Siri maintained her sense of humor with 

iOS CENTRAL

ASK CORTANA FOR directions to 
the nearest McDonald’s, and 
she’ll throw back this mobile 
web version of Bing. Ugh.
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“The carpet needs vacu-
uming.”

Both assistants are 
equipped to schedule 
reminders; Cortana’s are 
located in the sidebar, 
completely isolated from 
iOS Reminders, but synced 
to Cortana for Windows or 
Android. I understand why 
Microsoft made this 
decision, but it further 
impedes the utility of 
having Cortana on the 
iPhone to begin with.

BOTTOM LINE
If you own a Mac and rely 
on Siri to be your personal 
assistant on the iPhone 
and/or iPad, Cortana 
currently offers little 
incentive to switch. Most 
of the time she remains 
strangely silent, and lacks 
some of the personality we’ve come to expect from virtual assistants.

For those who call Windows 10 home but prefer an iPhone to a 
Windows Phone, the situation is a little different: Cortana provides a way 
to tap into your Notebook while away from the desktop, even if the 
experience is a limited one for now. ■

REVIEWS  |  CORTANA FOR iPHONEiOS CENTRAL

CORTANA HAS ITS OWN built-
in Reminders that sync with 
Windows and Android, but 
not with iCloud (or anything 
else, for that matter).
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What’s new  
at the App Store

BOOMERANG
Boomerang (go.macworld.com/
boomerangapp) is the latest 
offering from the folks at 
Instagram—it lets you take a few 
seconds of video that you can 
then loop back-and-forth, turning  
a simple action into a cha-cha 
dance. The resulting creations  
can, of course, be shared on 
Facebook or Instagram.

NOAA Hi-Def Radar Pro
NOAA Hi-Def Radar Pro (go.macworld.
com/hidefradarpro) shows “real-time 
hi-def animated weather radar images 
in vivid color” letting you easily track 

storms and hurricanes while they’re developing. It 
even shows you lightning strikes as they’re 
recorded, and offers the hourly forecast for the next 
24 hours. Most new weather apps try to pare down 
the information to the essentials; this goes the other 
direction—it’s for real weather nerds.

Microsoft Selfie
Microsoft Selfie (go.macworld.com/
msselfie) doesn’t just let you take 
selfies—it helps you look good in them. 
“The app takes age, gender, skin tone, 

lighting, and many other variables into account, 
applies different models automatically and finishes 
enhancement with just a single click. Users can 
transform average photos into more presentable 
portraits in seconds.”

Badland 2
The first Badland game was Apple’s 
Game of the Year back in 2013, and 
deservedly so: It was challenging and 
hauntingly beautiful, with an intricate 

sense of physics that made gameplay pure fun.  
Now the $4 sequel, Badland 2 (go.macworld.com/
badland2), is here, with more of the same, and 
expands the universe with online events designed 
to turn solo gameplay into a community event.

Practice+
Practice+ (go.macworld.com/practice 
plus) is a “complete practice and perfor-
mance toolkit” for musicians, working as 
a tuner, metronome, recorder, and more. 

The latest update includes Dropbox integration, 3D 
Touch capabilities, and a number of bug fixes.
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BY JOEL MATHIS 

Rubber duckie from the future
This month’s roundup features Edwin the Duck, a Bluetooth-enabled rubber duck 
that can interact with apps on your iOS device. Plus wireless earbuds, a smart outlet 
and a pico projector. 
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BEDDI  
Beddi (wittidesign.com) is a docking 
station and Bluetooth speaker with  
an array of features that show your 

iPhone off in its best light. It has multiple 
USB charging ports, a wake-up light, 

one-touch Uber calling, a white-noise 
generator, a built-in FM radio and  
more. Beddi has already made its 

crowdsourced funding goal, so look  
for this to be on the market soon.

EDWIN THE DUCK
Ever thought the world would need   
an app-controlled rubber duckie?  
Well, we’ve got one. Edwin the Duck 
(edwintheduck.com) is a $100 device— 
a bit pricier than your usual bathtime  
toy—that’s tricked out with Bluetooth 
technology. That way, your child can 
experience stories, play games, and  
sing songs with the duck thanks to  
the Edwin the Duck app.

http://www.softgozar.com


69

ACTIVEON
The $120 CX (activeon.com) is sort of a 
poor man’s GoPro camera—it features a 
super-wide view, full HD 1080-pixel video 
shot at 30 frames per second, and is easily 
mounted to capture the action in your life.

ALPHA AUDIOTRONICS
The $279 Skybuds (skybuds.com) is a two part 
device: One part is the wireless earbuds for 
music and calls. The other part is a case for 
your iPhone that can store and charge the 
earbuds. And if you’re worried about losing 
your tiny, but expensive, 
earphones, never 
worry: The 
Skybuds app can 
help you track 
them to the 
location you 
left them.
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Rubber duckie from 
the future
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NYRIUS  
The $40 Smart Outlet (nyrius.com) is a 
Bluetooth device—just plug your favorite 
appliance into the Smart Outlet (which, in 
turn, should be plugged into a regular old 
dumb outlet) and, voila, you have remote 
control of that appliance using your 
iPhone or iPad. 

SONY
The $350 Sony HD Pico Mobile 
Projector (sony.com) connects to 
your mobile devices, and projects  
a 1920-by-720 HD picture. It also 
features a built-in 3400mAh battery, 
which can be used as a backup 
battery for your iPhone or iPad.
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The Hunger Is campaign is a collaboration between The  
Safeway Foundation and the Entertainment Industry Foundation  
to raise awareness and improve the health of hungry children.
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The iPad Pro pushes the 
boundaries of tablets in 
interesting ways as a 
general-purpose laptop 
replacement, but how does 
it change the photography 
game? By Jeff Carlson

HOW THE iPAD PRO 
STACKS UP AS A 
PHOTOGRAPHER’S TOOL

FEATURE 
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P hotographers have been drawn to the iPad 

since the first model, hoping it can provide  

a mobile workflow when they’re away from  

their computers. The iPad Pro (go.macworld.

com/ipadprorev) pushes the boundaries of tablets in 

interesting ways as a general-purpose laptop replacement, 

but how does it change the photography game?

Editing photos, especially with the addition of Apple 

Pencil (go.macworld.com/applepencilrev) support in some 

apps, is a definite improvement, though limitations in iOS 

keep the iPad Pro from achieving its full potential as a 

photographer’s mobile companion.
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Photo editing
It’s impossible to ignore the 
beckoning light of that brilliant 
12.9-inch Retina screen, and the 
promise of nearly desktop-class 
processing power. Plenty of apps let 
you edit photos, such as standouts 
like Google’s Snapseed (macworld.
com/snapseed), Adobe’s Lightroom 
mobile (lightroom.adobe.com), VSCO 
(vsco.com), and of course Apple’s 
own Photos app.

Support for the Apple Pencil, 
though, adds another level of editing. 

Adobe’s Photoshop Fix (go.
macworld.com/photoshopfix) senses 
pressure and angle using the Pencil 
for precise adjustments. For example, 
when you need to lighten just one 
area of a person’s face, or discreetly 
erase some age wrinkles, you don’t 
need to wait until you’re back on 
your Mac. (Pixelmator (pixelmator.
com/ios) also supports the Pencil, 
though in my tests that applied more 
to drawing than retouching.)

The ability to multitask in apps that 
support it can also be helpful. 

REMOVING A 
BYSTANDER from a 
photo in Lightroom 
mobile (left) using 
Adobe Fix (right) in 
Split View.

FEATURE     i PA D PRO F OR PHOTOG R A PH ERS
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Lightroom mobile and Adobe Fix can 
run side-by-side, and they can both 
access the same libraries via 
Creative Cloud Sync, enabling you to 
send an image from Lightroom 
mobile to Fix to perform some spot 
healing, a feature missing in 
Lightroom mobile.

It’s still a RAW deal
One shortcoming for photographers 
is unchanged: there’s still no system-
level support for RAW formatted 

images. (If your camera doesn’t shoot 
in RAW mode, or you shoot only in 
JPEG formats, this point won’t hold 
you back.) The RAW files transfer to 
the iPad, but any edits you make are 
applied to the thumbnail preview the 
camera creates to display on its LCD. 
So, when you edit on the iPad, you’re 
not taking full advantage of the 
editing possibilities RAW formats 
offer. (If you do plan to edit, I 
recommend shooting in RAW+JPEG 
mode to work with a higher-

BEFORE AND AFTER 
using the Apple Pencil 
to lighten the right 
side of the face.
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resolution original.)
The closest to a seamless 

experience is shooting raw and using 
iCloud Photo Library. You don’t edit 
the raw image itself on the iPad, but 
changes you make are applied to a 
JPEG version the Photos app creates 
and saves with the original. That 
edited version shows up as the 
image on your Mac and other 
devices—it’s not a separate copy, 
which is created when you edit in 
other apps. However, that JPEG 
becomes the edited version; if you 
were to continue editing it in Photos 
on the Mac, for example, you’d be 
working with the JPEG version, not 
the RAW version.

Another thing to keep in mind, 
although it’s not a surprise, is that the 

iPad Pro doesn’t offer color 
management or alternative color 
spaces—you get sRGB and that’s it. 
(This has been the case with all 
iPads.)

Organizing
I’d hoped that the iPad would be a 
great field photo-triage tool: import 
photos directly, sort and rate the 
images, and assign keywords—
basically, handle a lot of the less-
exciting tasks of managing one’s 
photo library during the downtimes 
before you get back to a home or 
office Mac.

But for a variety of reasons, the 
iPad isn’t part of most workflows at 
that stage. A poll I ran on my iPad for 
Photographers site (go.macworld.

FEATURE     i PA D PRO F OR PHOTOG R A PH ERS
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com/ipad4photog2015survey) 
revealed that people aren’t bothering 
to assign keywords or ratings to 
images on the iPad; the prominent 
apps that enabled this, Photosmith 
and PhotosInfoPro, are no longer 
being updated. When you import 
images, they’re saved in the Photos 
app, where you can only mark shots 
as favorites and move them into 
albums.

If you primarily use Lightroom on 
the desktop as your editor of choice, 
it’s more common to flip the model 
around: Import photos into Lightroom 
CC on the Mac, sync them using 
Creative Cloud, and then work on 
rating and editing the images using 
the Lightroom mobile app on the 
iPad at your leisure. The edits apply 
non-destructively, and Lightroom 
bypasses the RAW issue by 
converting RAW images to Adobe’s 
DNG (Digital Negative) format during 
sync.

The bright spot here is Apple’s 
new Lightning–to–SD Card adapter, 
which supports USB 3 speeds when 
transferring images from a memory 
card to the iPad. In the past, I must 
admit, I’d almost given up on 
importing via the Lightning port, 
because even loading thumbnails 
before importing is agonizingly slow. 
Now, it’s much faster: in one test I 
performed, bringing in just 40 
RAW+JPEG photos totaling 1.5GB 

took 30 seconds with the new 
adapter, compared to 2:20 using the 
old adapter. (The USB 3 speeds 
apply only to the iPad Pro; the 
adapter achieves USB 2 speeds on 
other recent iPad and iPhone 
models.)

A developing story
As with many things about the iPad 
Pro, the superior hardware is waiting 
for the software to catch 
up. Gradually, third-party 
developers are adding 
Pencil support for image 
retouching, which is a 
welcome jump forward. 
And all image editors 
benefit from the speed 
gains enabled by the 
iPad Pro’s faster proces-
sors. But the lack of 
RAW support in iOS 
hinders pro and enthusiast photogra-
phers from developing workflows 
that avoid duplicating work or 
depending on a Mac to get started.

Granted, iOS has always been 
designed for the broadest possible 
audience, and even in a device 
labeled “Pro” that same foundation 
applies. Now that the iPad Pro is 
released, I’m holding out hope that 
Apple will take action to help it fulfill 
its potential. ■

AS WITH MANY 
THINGS ABOUT 
THE iPAD PRO, 
THE SUPERIOR 
HARDWARE IS 
WAITING FOR 
THE SOFTWARE 
TO CATCH UP. 
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FEATURE

PARTY GAMES 
PERFECT  

FOR YOUR iPHONE, iPAD, & APPLE TV
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When you throw a party, you want it to be fun and 

stimulating for everyone who attends, but 

sometimes, despite our best efforts, a party 

might need help getting started. So if your 

tunes, tapas, and talk aren’t getting the job done, perhaps 

your iPhone and Apple TV can help. We’re not talking about 

recipes or music—if your shindig is eliciting more yawns 

than yucks, perhaps all that’s needed to lighten the mood is 

a good game. Here are a few of our favorites.

VIDEO
To view this video, 

go to go.
macworld.com/
partyappsvid
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HEADS UP
$1  |  iOS  |  GO.MACWORLD.COM/HEADSUP

The Ellen DeGeneres–created guessing game might have 
seemed like a flash in the pan when it took the App Store by 
storm last year, but Heads Up is still the best party game 
around. The concept is simple: Try to guess words and phrases 
based on clues from your friends–while holding your iPhone 
up to your forehead. A variety of categories (even a new Star 
Wars pack) will keep everyone engaged, and the fast-paced, 
captivating gameplay will get even the most antisocial guest 
involved. Fun, irreverent, and just the right amount of wacky, it’s 
sure to turn any party into a memorable one.
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SKETCH PARTY TV
$6  |  iOS/APPLE TV  |  SKETCHPARTY.TV

If you like Pictionary but hate cleaning up all those scraps 
of paper, Sketch Party TV is the game for you. It’s every-
thing you remember about the classic drawing game 
updated for the post-pad revolution. As you draw on your 
iPhone or iPad, your artwork is beamed to your Apple TV 
for all to see, as your team shouts out guesses for the clue 
you’re trying to illustrate. But be warned: with custom word 
lists, a full-color palette and support for up to 16 players, 
your guests might never want to leave.
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PHRASE PARTY 
$2  |  iOS/APPLE TV  |  GO.MACWORLD.COM/PHRASEPARTY2

Musical chairs and hot potato might not be the first games 
you think to play with a bunch of grown-ups, but Phrase 
Party combines them into a surprisingly smart and amusing 
game of luck and skill. It has a similar concept to Catch 
Phrase (in that you’re trying to get your teammates to guess 
the words that are on your phone), but it ups the ante by 
passing around an iPhone with each correct answer. When 
the buzzer sounds, the person holding it loses. With a trio of 
play modes and a variety of categories it’s sure to keep you 
coming back for more.
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SING! KARAOKE 
FREE  |  iOS/APPLE TV  |  GO.MACWORLD.COM/SING!KARAOKE

Nothing quite brings a party together like a bunch of your 
friends singing top 40 radio hits off-key and out of sync. 
And the kind folks at Smule will make sure they butcher 
your favorite songs all night long. From “Let It Go” to 
“Thinking Out Loud,” Sing! Karaoke’s bountiful library will 
satisfy all musical tastes and will have your guests cheer-
ing, laughing, and, of course, singing your praises. And 
Smule’s series of vocal filters will make sure even the 
worst singers at your party still sound pretty good.
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JUST DANCE NOW 
FREE  |  iOS/APPLE TV  |  JUSTDANCENOW.COM

You don’t need to own a Wii to get into the groove. Just 
Dance Now on your iPhone and Apple TV uses the same 
technology to get everyone on their feet and moving. A 
massive catalogue of hits, club-thumpers and rump-shakers 
(mostly available through in-app purchases) will get your party 
started quickly, and even guests who have Android phones 
can join in the fun by using the Siri remote to track their move-
ments. So turn down your Sonos and turn up your TV while 
you and your guests literally dance the night away.
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REVERSE CHARADES 
FREE  |  IOS  |  REVERSECHARADES.COM

There’s a reason Charades is one of the most popular party 
games of all time: It’s fun, it’s easy, and it can provide hours of 
entertainment. Reverse charades takes that concept and flips it 
on its head. Instead of acting out a word for your team to guess, 
your team does the acting, reeling off as many clues as you can 
decipher before the timer ends. The result is a game that’s more 
challenging and even more raucous than the original without 
losing a bit of its charm.
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PARTY PONG 
FREE  |  APPLE TV

You probably aren’t planning to put a Beirut table in the center of 
your classy holiday party, but if you truly want to bring your party 
to the next level, there’s really no better way than bouncing 
plastic balls into red cups. Thankfully, Party Pong has you cov-
ered. It’s just like the way you remember it from college—a long 
table, one ping-pong ball and 10 red cups—but when someone 
misses you won’t get a spill on your freshly cleaned rug. And 
since it uses digital refreshments and not alcoholic ones, even 
the kids can get in on the fun.

FEATURE     PERFECT PA RT Y GA M ES
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WHAT IF…? 
FREE  |  iOS  |  GO.MACWORLD.COM/WHATIF

Sometimes the best party games 
are casual ice-breakers, so if you’re 
looking for something a little less 
formal, What If…? will be sure to 
liven up your party without forcing 
anyone out of their comfort zone. 
Whether you’re hosting four people 
or 40, the app’s catalog of quixotic 
queries is a perfect way to warm up 
and please the crowd. Questions 
like “What if there was peace on earth but the 
Internet disappeared?” won’t just thaw the ice 
between unfamiliar guests–they might even 
reveal sides of your friends’ personality that 
you never knew existed.
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WORKING MAC Tips, Tricks, and Tools to Make You 
and Your Mac More Productive

These 4 Chrome extensions 
make Gmail better right now
These add-ons will track your messages, schedule your meetings, and more.

BY MICHAEL ANSALDO
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eliminates that legwork by providing 
the job titles, company details, and 
social accounts for each email sender. 
Without leaving your inbox, you can 
scroll through their Facebook posts, 
tweets, and other social updates. 
Add your own notes, then sync all 
the contact’s info to your address 
book so you’ll always have it at hand.

FULL CONTACT
Most of us have a similar reaction 
when we receive an email from a 
new professional contact. We 
immediately try to learn more about 
them by searching their profiles on 
LinkedIn, Facebook, Twitter, and 
other social networks.

Full Contact (fullcontact.com)

Gmail raised the bar for what we expect in an email 
service. But if you’re only using its native features, 
you’re getting just a taste of its power. There are a 
wealth of Chrome extensions that expand Gmail’s 

capabilities and help you streamline your workflow. Here are four 
you should install today.

FULL CONTACT SHOWS 
you email senders’ 
social profiles and 
other details.

89

http://www.softgozar.com


WORKINGMAC CHROME EXTENSIONS FOR GMAIL

SNAPMAIL
We don’t recommend emailing 
passwords and similarly sensitive 
material. But if you absolutely must, 
this Mission Impossible–style 
extension (snapmail.co) will ensure 
your message is seen by authorized 
eyes only.

SNAPMAIL ENCRYPTS 
and destroys sensitive 
email messages.

MIXMAX ADDS several 
functions to Gmail, 
including “instant” 
meeting scheduling.

It adds a Snapmail button next to 
the Send button in your message. 
Pressing it encrypts the message and 
creates a URL for the message, which 
is sent to the recipient. Once the 
recipient follows the link, a count down 
timer informs them that the message 
will self-destruct in 60 seconds.
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MIXMAX
MixMax (mixmax.com) delivers on its 
promise to “make email awesome.” 
The extension adds a host of must-
have functions to Gmail, including 
email tracking, one-click business 
templates, and “send later” schedul-
ing.

Its Instant Scheduling is particu-
larly useful for setting up one-on-one 
meetings. MixMax does all the heavy 
lifting so you and the other party 
don’t have to email back and forth to 
find a time that works for you both. 
You select available times from your 
Google Calendar, and MixMax adds 
them to your email. Your recipient 
selects whichever one works for 
them, and MixMax puts it on your 
calendar and sends each of you a 
confirmation message. It’s like having 
your own personal assistant.

MAILTRACK
MailTrack (mailtrack.io/en) removes 
the mystery around unanswered 
emails. This extension is a simple 

email tracker that uses checkmarks 
to keep you apprised of your mes-
sage’s status. It adds one checkmark 
next to the message when it’s sent 
and adds a second once the mes-
sage has been read. Best of all, it can 
tell you exactly which recipients have 
read a message sent to multiple 
parties.

MailTrack’s basic functions are free 
for an unlimited number of emails. 
For $3.50 a month you can add 
options including real-time desktop 
notifications and daily tracking-
activity reports. ■

THE MAILTRACK 
extension lets you 
know when recipients 
have read your email, 
even one sent to a 
group of people.
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A primer in 
Profile Manager: 
The Server app
Built into OS X Server, Profile Manager is used to manage the devices 
in your business or organization.

BY JEFFERY BATTERSBY

WORKINGMAC
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and take action on Server alerts, view 
Server logs, and graphical statistics 
for services you have running.

2. Accounts: Used to create and 
manage user accounts and groups.

3. Services: For managing the 
most commonly used services.

4. Advanced: For managing less 
frequently used services.

If you don’t see any information 
displayed underneath any of these 
sections, move your mouse on top of 
a section title and you should see the 

APPLE’S SERVER  
(YUP! IT’S REALLY AN APP)
If you’re used to working with typical 
server software, you’re also used to the 
notion of a server operating system, 
such as Microsoft’s Windows Server 
2012. Apple’s Server app is a horse of a 
different color, which is to say, it’s an 
app running on Apple’s El Capitan 
operating system. Install and set up the 
app, and you have all the features of a 
server operating system. Drag the app 
to the Trash and the app will detect that 
it’s no longer in the Applications folder 
and will turn off all the services. 
Re-install and open the Server app, and 
you will once again have a functioning 
server. It’s so simple that, if you’re used 
to other server environments, it can 
initially be a little confusing.

INSIDE THE SERVER APP
If you haven’t done so already, open 
the Server app and let’s take a look 
around. One of the first things you’ll 
see is that the app’s sidebar is 
organized into four sections:

1. Server: Used to view and 
change information about your 
server, manage Apple AirPort base 
stations for use with your server, view 

Last month, we completed the process of installing El 
Capitan and the Server app on an external hard drive. 
Now we’ll look at the Server app’s features, and we’ll also 
get started with Server’s remote management features.
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word Show. Click your mouse button 
while you see Show and the services 
under that section should appear.

Services are active when you can 
see a little green dot next to the 
service name.

At this point in time, you shouldn’t 
see any services active. If any 
services are active you can turn them 
off, unless, of course, you’re working 

in an active server environment.
You turn services on and off by 

selecting one in the sidebar of the 
Server app and flipping the Services 
switch to the On or Off position. If you 
want to take a quick look at turning on 
a service that you should be running, 
have a look at “Save your bandwidth 
by using a caching server (go.mac-
world.com/cachingserver).”

PROFILE MANAGER: THE SERVER APP
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SERVER INFORMATION
Select your server under the Server 
section in the sidebar of the Server 
app. When it’s selected you should 
see four tabs across the top of the 
Server app window.

1. Overview: Displays information 
about your server, including your 
server’s host name, external IP 
address, current version of the OS and 
Server app running on your server, 
and available network interfaces.

2. Settings: Lets you manage your 
server’s remote access options and 
Apple’s Push Notification Services, 
and change your service data location.

3. Storage: Allows you to view 
every disk attached to your server 
and for managing access to the files 
and folders located on those disks.

4. Access: Lets you define which 
users will have access to the services 
you’re hosting on your server.

TURN ON REMOTE ACCESS
At the moment, you’re probably 
managing your server using a mouse 
and keyboard connected to the 
computer that Server is running on. 
While that’s practical when you’re 
only working with one server, the 
reality is that you want to be able to 
manage servers when you’re not 
sitting directly in front of them, either 
while they’re in a server room 
somewhere or while you’re at a 
remote location and your server is at 
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the office. Apple’s Server app allows 
you to do this, but not without first 
enabling Remote Access services.

To do this:
1. Click the Settings tab.
2. Locate the Remote access 

section and put checks in the boxes 
next to the following: Screen Sharing 
And Apple Remote Desktop App and 
Using Server App On A Remote Mac.

We’ll show you how to connect to 
your server remotely in the following 
article, “A Primer in Profile Manager: 
Manage Your Server Remotely.” ■

PROFILE MANAGER: THE SERVER APP
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A primer in Profile Manager: 
Manage your server remotely
How to use remote management with OS X El Capitan Server.

BY JEFFERY BATTERSBY
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Finder’s Go Menu, click the Network 
menu item and locate your server in 
the list of servers that appears.

2. With your server selected, click 
the Share Screen button. (Note: 
Depending on the Finder view you’ve 
chosen, it’s possible you won’t see 
the Share Screen button. If you don’t, 
click the Finder’s Show Items In 

WORKINGMAC PROFILE MANAGER: REMOTE MANAGEMENT

Now it’s time to check and see if 
remote management works. To 
perform this part of the setup you’re 
going to need another Mac with the 
Server app installed.

Before we begin, double-check to 
make sure that both Screen Sharing 
And Apple Remote Desktop App and 
Using Server App On A Remote Mac 
are checked under the Settings tab 
in the server app.

1. Click your server’s name in the 
sidebar of the Server app.

2. Click the Settings tab.
3. Verify that both the screen 

sharing and remote access options 
are selected.

SCREEN SHARING
The first service we’ll verify is screen 
sharing, to make sure we can con-
nect remotely to our server and 
control its screen. In order to perform 
this task, you’ll need to have another 
Mac you can use that is on the same 
network as your server.

1. Open a Finder window and 
locate and click your server in the 
sidebar. If you can’t locate your 
server in the sidebar, open the 

In the previous article of this primer series, we enabled your 
server for remote access. Enabling your server’s remote 
management features allows you to remotely control your 
server’s screen, and use the Server app to remotely man-

age services on your server.
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Columns button.)
3. After clicking the Share Screen 

button, you should see an authenti-
cation window. Enter your server’s 
administrative user ID and password.

Once you’ve authenticated, you 
should be able to control your server 
remotely.

Leave the screen sharing session 
open for a few minutes so we can 
compare differences between a 
screen sharing session and a remote 
management session.

REMOTE MANAGEMENT
The second sharing feature we 
enabled was remote server manage-
ment, which allows you to remotely 
manage services on your server 

using the Server app on another 
Mac. In order to use this feature, you 
have to download the Server app in 
the computer you want to use to 
remotely manage your server.

1. Open the App Store app.
2. Click the Purchased tab.
3. Locate the Server app and click 

the Download button.
4. Once the app is downloaded, 

drag it from the Applications folder to 
the Dock, just as we did in part 2 of 
the Primer.

5. Open the Server app.
It’s very important that you select 

your server from the list of servers in 
the Choose A Mac window that 
appears when you open the Server 
app. If you choose This Mac and click 
Continue, the Server app will begin 
setting up services on your adminis-
trative Mac. If you do not see the 
Choose A Mac window when you 
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open the app, select the Server app’s 
Manage menu and select Connect To 
Server.

From the Choose A Mac window:
1. Select your server.
2. Click continue.
3. Enter the name and password 

for your administrator and click 
Connect. After connecting to your 
server, you may see a message 
stating that your server is using an 
unverifiable SSL certificate.

If you see this:
4. Choose the option to trust the 

certificate.
5. Click continue.
6. Enter your current computer’s 

administrative user ID and password.
Once you’ve completed these 

steps, the Server app will open 
displaying information about your 
server. Compare the Server app 
running remotely with the Server app 
running in your screen sharing 
session, you should see that it looks 
exactly the same with one exception: 
Under Server’s Settings tab, your 
remote app cannot make changes to 
the Remote Access setting for using 
the Server app on a remote Mac.

In the next article, we’ll set up 
Open Directory so we can begin 
managing devices using profile 
manager. ■

PROFILE MANAGER: REMOTE MANAGEMENT
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A primer in Profile Manager: 
Set up Open Directory
The last major step before turning on Profile Manager is turning on Server’s Open 
Directory service so that you can centrally manage network user accounts.

BY JEFFERY BATTERSBY
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as www.apple.com and returns an IP 
address that your computer uses to 
locate that computer on the Internet 
or your network.

A reverse address takes an IP 
address and returns a FQDN.

CHECK FOR CORRECT DNS 
RECORDS
My server’s FQDN is pmserver.
reyespoint.com and has an IP 
address of 10.0.1.23, although this 
isn’t a publicly available URL. You can 
check to see if your DNS server has 
a forward and reverse record for your 
server by opening the Network Utility 
and using the Lookup tool:

1. Use Spotlight to open the 
Network Utility. You can open Spot-
light by clicking the magnifying glass 
in the upper right of your menu bar 
or by typing Command-Space on 
your keyboard.

2. Click the tab that says Lookup.
3. Type Your Server’s IP address in 

the address field and click the 
Lookup button. You should see 
something that looks like the follow-
ing: 10.0.1.23 -> pmserver.
reyespoint.com, only the server 

WORKINGMAC PROFILE MANAGER: OPEN DIRECTORY

If you’re not using a directory service, 
Open Directory is an excellent way to 
manage users in a small office 
environment. If you’re already using a 
directory service, such as Microsoft’s 
Active Directory, once you turn Open 
Directory on you can bind your 
server to your Active Directory server 
and use Profile Manager with users 
created in your Active Directory 
environment.

WHAT’S IN A HOST NAME?
In order for your server to be acces-
sible over the Internet we first need 
to set it up for access over the 
Internet. Normally this would require 
that you’ve registered a domain 
name for your server. That’s more 
than we can cover here—although 
that may be fodder for a future 
Working Mac column—but at the very 
least we need to make sure that 
there are DNS records set up for your 
server in your network.

DNS records are like the forward 
and reverse phonebooks of the 
Internet.

A forward address takes a fully 
qualified domain name (FQDN), such 

The last major step we need to take before turning on 
Profile Manager is turning on Server’s Open Directory 
service so that you can centrally manage network 
user accounts. Open Directory is required for using 

Profile Manager.
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name should be your server’s FQDN. 
This is a reverse lookup.

4. Now type your FQDN in the 
address field. You should see some-
thing that looks like the following: 
pmserver.reyespoint.com -> 

10.0.1.23, only the IP address 
should be your server’s IP address. 
This is a forward lookup.

If your lookup results in an error, it 
means that your DNS server doesn’t 
have a record for your server. If you 
were expecting your DNS server to 
have a record, check with your DNS 
admin or double-check and DNS 
settings you’ve created. If your 
network doesn’t have a DNS server 
for computers in your network, our 
next step will turn on the Server 
app’s DNS server for you.

Note: Under most circumstances 
having the Server app turn on the 
DNS server for you is an error, unless 
you’re working in a small office and 
this is the first server you have set up 
on your network.

EDIT YOUR HOST NAME
Now it’s time to set your server up for 
access over the Internet.

1. Open the Server app and select 
your server in the sidebar.

2. Make sure the Overview tab is 
selected and click the button that 
says Edit Host Name (Take note of 
your server’s Host Name, it is likely 
something such as PM-Server.local).
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telling you that changing your host 
name may cause running services to 
stop working correctly. Click the 
Change Host Name button.

8. If your DNS is working, the 
process will complete and you 
should see your host name updated 
to reflect your FQDN. If your DNS is 
not working properly you will see a 
message asking if you want to 
automatically set up DNS. Click the 

WORKINGMAC

3. An information window will 
appear explaining what a Host Name 
is used for. Click the Next button.

4. A new sheet will appear asking 
how you want devices to access your 
server. Choose Internet and click 
next.

5. The next sheet has two fields 
where you can make changes to your 
server’s name. If DNS was working 
properly in the previous exercise, the 
host name field should display your 
server’s FQDN. If server could not 
resolve your host name from your IP 
address, change that name from 
whatever is in the field to yourserver-
name.yourdomain.com (or whatever 
your top level domain is, such as .
edu, .net, .ca, etc.).

6. Click the next button.
7. You’ll see a warning message 

PROFILE MANAGER: OPEN DIRECTORY
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Set Up DNS button ONLY if you are 
not expecting for there to be a 
record for your server in your DNS 
server.

When this process completes the 
host name field should display your 
server’s FQDN.

TURN ON OPEN DIRECTORY
Now that your server has a proper 
host name that resolves to an IP 
address using DNS, let’s set up Open 
Directory.

1. Locate and select Open Direc-
tory under the Advanced section in 
the sidebar of the Server app.

2. Click the Open Directory 
service’s on button.

3. A new sheet appears asking 
what kind of Open Directory server 
you’d like to create. Select “Create a 
new Open Directory domain” and 
click the Next button.

4. A new sheet appears asking 
you to create an administrative 
account to manage network users 
and groups. Leave the Name and 
Account Name fields with the default 
information, enter and verify your 
administrative password, then click 
the Next button.

5. In the sheet that appears, enter 
your organization name and your 
email address, then click Next.

6. Confirm that the information you 
just entered is correct and click the 
Set Up button. Click the Previous 

button and make changes if it isn’t.
It may take a minute or two for the 

creation of your Open Directory 
databases to complete. When the 
process does complete you should 
see a green dot appear next to the 
service in the sidebar and your 
server should appear in the list of 
servers with the word Master in the 
type column.

That’s it! We’re now set to begin 
working with Profile Manager. That’s 
next. ■

105

http://www.softgozar.com


A primer in Profile Manager: 
Turn on Profile Manager
How to set up and manage devices using OS X Server’s Profile 
Manager service.

BY JEFFERY BATTERSBY

WORKINGMAC
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a check in the box that says “Always 
trust com.apple.servermgrd when 
connecting to yourservername.
yourdomain.com” and click continue.

6. Authenticate as an administrator 
and click Update Settings.

A new remote management session 
for your server should now be open. 
Locate and click Profile Manager 
under the section that says Services.

TURN ON PROFILE MANAGER
The plan here is to use a Mac other 
than your server for setting up, 
connecting to, and managing Profile 
Manager. It’s not necessary for this 
lesson, you can perform these tasks 
on your server, but you will need a 
second computer for every episode 
following this one.

On a second computer:
1. Download and Open the Server 

app.
2. Locate your server in the list of 

servers, select it and click Continue.
3. Authenticate using the directory 

administrator ID and password you 
created in the last lesson.

4. You should now see a window 
asking you to verify your server’s SSL 
certificate. (If you don’t, it may be 
because you’ve already trusted the 
certificate in a previous lesson or 
you’re using a certificate signed by a 
trusted certificate authority.) Click the 
button that says Show Certificate.

5. In the resulting window, if you 
want, you can click the disclosure 
triangle next to Trust and Details to 
look at your certificate, otherwise, put 

We have (finally) 
arrived at the 
day you’ve all 
been waiting 

for: It’s time to turn on Profile 
Manager.
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As is the case with so many of the 
Server app’s services, you don’t have 
to do much to get Profile Manager up 
and running. In this case, all you 
need to do is turn the service on and 
it will begin working. We need to do 
more to configure it, but you can get 
started with just the flick of a switch.

7. Click the switch that turns Profile 
Manager on.

Take note of the Status section at 
the top of the Profile Manager 
window. Initially, it will say Starting 
but very shortly it should say, “Avail-
able at yourserver.yourdomain.com.”

TEST TO SEE IF PROFILE 
MANAGER IS WORKING
Now that the Profile Manager service 
is started, it’s time to test and make 
sure it’s running.

1. Open Safari.
2. Type yourserver. 

yourdomain.com/profilemanager 

in the address field and press the 
Return key.

3. At the login window, enter your 
Server Administrator user ID and 
password.

4. Select Users in Profile Man-
ager’s Library sidebar, locate and 
select your administrative user.

You should only see your server 
administrator in this list, although, it is 
possible you’ll see other users if you 
already had users on your computer 
when you installed Server or if you’re 

bound to another Directory Server in 
your environment. If you do see other 
users, use the search field to find and 
select your server admin.

TURN ON PROFILE MANAGER
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You’ll see a different webpage 
titled My Devices that your users can 
use to enroll their personal devices in 
your system. Before they can log in 
to this portal, you’ll need to create 

This browser-based Profile Man-
ager is used to manage users and 
devices, which allows you to change 
settings and provide access to server 
resources remotely. We’ll begin 
looking at more of Profile Manager’s 
management features in a subse-
quent lesson, but for now, we’re 
going to look at another of Profile 
Manager features.

1. Click the menu at the upper right 
of Profile Manger in your browser—it 
should display your server adminis-
trator’s name.

2. Click Log Out.

TESTING MY DEVICES
Profile Manager offers a feature 
allowing your users to enroll their 
personal devices in your manage-
ment system. This feature is great for 
when you want to provide access to 
company resources on personal 
devices while guaranteeing that your 
users aren’t exposing private data. 
We’ll talk more about the “whys” and 
“hows” of introducing personal 
devices into your corporate system, 
but for now, let’s just check and make 
sure it’s working properly.

1. In your browser’s address bar, 
type yourserver.yourdomain.
com/mydevices. Take note that you 
need to type mydevices and not 
profilemanager after the /.

2. Log in using your administrative 
user ID and password.
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Open Directory accounts for them. 
Also, take note that you can, at this 
time, only download a Trust Profile 
using this portal. This is because we 
haven’t yet turned on Device Man-
agement for your server in Profile 

TURN ON PROFILE MANAGER

Manager. 
To learn more, go to “A Primer in 

Profile Manager” (go.macworld.com/
profilemgrprimer). ■
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— EINSTEIN
  adopted 12-09-10

SURE,
AT FIRST I WAS A LITTLE TAKEN ABACK 

BY THE WHOLE PEEING STANDING UP THING. 
BUT I TAUGHT HIM TO THROW A STICK 

AND NOW HANGING OUT WITH HIM
IS THE BEST PART OF MY DAY. 
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CREATE Using the Web for Video, Graphics, Publishing, 
Photography, and Other Creative Pursuits

How to share Live Photos 
with non-iPhone users on 
Instagram and via text
Love taking Live Photos with the iPhone 6s? These 3 apps can share Live 
Photos even outside the iOS ecosystem.

BY OSCAR RAYMUNDO
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And the only way to store a fully 
animated Live Photo is by uploading 
it to the iCloud Photo Library.

Just because Live Photos don’t 
have widespread support on social 
media and file storage services yet 
doesn’t mean that you can’t share 
them on Instagram or save them in 
Google Photos. These three iOS apps 
can help you convert your Live Photos 
into GIFs or video—and they offer a 
few other nifty photo features too.

LIVELY
If you are looking for an 
app that simply converts 
Live Photos into GIFs or 
video, the easiest to use 

is Lively (lively.tinywhale.net). After 
launch, the app surfaces only the 
Live Photos from your camera roll. 
Once you pick the one you want to 
convert, Lively gives you the option 
to choose whether you want to 
convert it as a GIF or as a video file. 
GIFs are great if you want to share 
them via SMS or a messaging service 

The ability of the iPhone 6s and 6s Plus to capture Live 
Photos is nothing short of magic. Live Photos are not 
GIFs nor video, but still JPEG images that “move” once 
you deep-press on your iPhone screen. Anyone with 

an iPhone running the latest iOS 9 can view them, but the only 
way to share them is sending them via iMessage or posting them 
on Tumblr, which just recently became the first photo-sharing 
app to support Live Photos. 

like Facebook Messenger, Slack, and 
GroupMe. Lively also gives you a few 
playback options if you choose to 
convert your Live Photo as a GIF. You 
can speed it up or play it in slo-mo, 
as well as play it backwards or in 
auto-reverse. Choose to convert your 

LIVELY RECENTLY GOT a 
2.0 update that brings 
more functionality to 
the app
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Live Photo to a video if you want to 
post it on Instagram or Vine.

Lively recently got a 2.0 update that 
brings more functionality to the app. 
Lively’s latest version lets you trim 
your Live Photo before converting, so 
you can remove any unwanted parts 
you accidentally took while trying to 
capture the perfect moving image. 
Lively 2.0 also lets you pick out a still 
frame from your Live Photo and save 
it to your camera roll. The app is free, 
but it costs a single in-app purchase 
of $2 to remove the Lively logo 
watermark from appearing in your 
exported GIFs.

LIVE STUDIO
Converting Live Photos 
as GIFs or video works 
very similar in Live Studio 
(livestudio.appsites.

com), but unlike Lively, this app does 
not offer customizable playback 
options when converting a GIF. If you 
want to convert the Live Photo as is 
with no trimming or auto-reverse, the 
Live Studio does it fine in just a few 
taps. The app costs 99 cents, and it 
does not tack on any sort of watermark 
to your exported files.

The best thing about Live Studio, 
however, is that it also works the other 
way around: giving you the option to 
convert videos, GIFs and photo-bursts 
into Live Photos. Talk about magic, the 
Live Studio app has somehow tapped 

into Apple’s Live Photo-making 
technology. We converted a video clip 
into a Live Photo, and we were able to 
activate the Live Photo when we 
deep-pressed it. This works even with 
video clips that are longer than three 
seconds (Live Photos “move” by 
capturing 1.5 seconds before and 
after you tap the shutter), in essence 
giving you the ability to create longer-
lasting Live Photos. This is great for 
converting a video clip or GIF that you 
would like to set as an animated 
wallpaper on your iPhone 6s.

PICPLAYPOST
Let’s say you take so 
many Live Photos that 
you want to share a few 
of them in collage form, 

PicPlayPost (go.macworld.com/
picplaypost) will help you do just 
that. This app creates a single 

LIVE STUDIO ALSO 
gives you the option 
to convert videos, 
GIFs, and photo-
bursts into Live 
Photos. 

LIVE PHOTO SHARINGCREATE
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PICPLAYPOST CREATES A single collage from different 
types of media: photos, video, GIFs and now Live 
Photos.

collage from different types of 
media: photos, video, GIFs, and now 
Live Photos. The app is free, but it’s 
a single $3 in-app purchase to 
remove the watermark from all 
exported collages.

Begin by selecting the layout of 
your collage and tap to add a “Photo 
& GIF.” If you pick a Live Photo, the 
app will ask you if you want to use 
the still photo or the Live one. You 
can choose whether each Live Photo 
plays on a loop, and even add music 
to your moving collage. After you 
finish putting it together, PicPlayPost 
will convert the Live Photo collage as 
either a video or a GIF.  ■
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Color space matters when ordering prints or other print projects online. 
Here’s how to make sure your projects look their best.

BY LESA SNIDER

How to check your photo’s 
colors before ordering print 
projects online
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Once in a while you 
may want to print 
your photography, 
whether a picture 

that you’ll frame, a greeting 
card to send friends, or a 
calendar, book, or other photo 
project to order online.

Because it’s challenging (if not 
impossible) to print some of this stuff 
at home, it’s best to leave the printing 
to pros such as Apple (using iPhoto 
or the Photos app), services such as 
mpix.com, your local camera store, or 
even Costco. The downside is that if 
you use an image-editing app such 
as Photoshop, Elements, or Light-
room, the colors in your printed 
pictures may not look like you 
expect, as you can see from the three 
versions of the tulip image at right.

The problem is rooted in the 
difference between the color space 
of your image versus the color space 
used by online printing services. In 
this column, you’ll learn how to 
control the color space in Photoshop, 
Elements, and Lightroom to be sure 
the colors you see on your display 
are as close as possible to the colors 
you get in the printed projects you 
order online.

WHAT IS COLOR SPACE?
Without diving too deeply into 

technical territory, color space refers 
to the range of colors available when 
your image is captured, displayed, or 
printed. Color spaces have names 
such as Adobe RGB (1998), ProPhoto 
RGB, sRGB, and CMYK. These color 
spaces vary in size and thus the 
range of colors they can produce. For 
example, next to the human eye, 
ProPhoto RGB is the largest color 
space to date, followed by others 
such as Adobe RGB (1998), sRGB, 
and CMYK.

Most online printing companies 
assume that your photos use the 
sRGB color space, which includes the 
printing services mentioned above as 
well as Shutterfly, Snapfish, Smug-
Mug, and so on. Fortunately, sRGB is 
the default setting for capturing 
JPEGs in most cameras—including 
iOS devices—and it’s the standard 
color space for the Internet and 

THE COLORS IN your 
printed pictures 
may not look like 
you expect.
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iPhoto and the Photos app. (If you’re 
capturing images in RAW format, you 
can assign any color space you want 
to them, though raw conversion apps 
such as Camera Raw, Lightroom, and 
Aperture use ProPhoto RGB.)

SOFT PROOFING
However, if the image was captured 
on a high-end camera with a different 
color space; if you use a different 
color space in Photoshop, Elements, 
or Lightroom; if the image was 
scanned from a printed photo; or if it 
was given to you and you don’t know 
how it was created, then the image 
may live in a different and larger 
color space than sRGB. Happily, 
Photoshop, Elements, and 
Lightroom can show you 
what the image will look like 
when the photo’s colors are 
limited to the sRGB color space. All 
but Elements lets you view the image 
in a different color space—a process 
called soft proofing—without actually 
converting the file to the smaller 
sRGB color space (so you don’t lose 
data). Soft proofing gives you the 
opportunity to tweak the colors to 
your liking before you have it printed.

After you’re finished editing the 
image, here’s what you do: In 
Photoshop, open the image and 
choose View → Proof Setup → 
Internet Standard RGB (sRGB). Next, 
choose View → Proof Colors (or 

press Command-Y) to see your 
image in sRGB. If the image looks 
good, you’re done. If it doesn’t, use 
the method of your choice to make 
the colors look like you want (say, 
using a Hue/Saturation adjustment 

IN THIS INFOGRAPHIC, you can see how small the sRGB color space is (pictured 
in color) when compared with Adobe RGB (1998) and ProPhoto RGB.

Adobe RGB (1998) vs sRGB

ProPhoto RGB vs. sRGB
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layer). When you’re finished, choose 
Edit → Convert To Profile and, in the 
resulting dialog box, choose sRGB 
from the Profile menu in the Desti-
nation Space area.

To save a copy of your photo in 
this new color space, choose File → 
Save As and choose JPEG from the 
Format menu. In the JPEG 
Quality dialog box that 
opens, enter 12 into the 
Quality field and click OK. 
This gives you a new file 
ready for uploading to an 
online printing service.

Photoshop Elements 
doesn’t have a soft-proofing 
option, but you can convert 
the image to sRGB. To do 
that, open an image in 
Expert mode and choose 
Image → Convert Color 
Profile → Convert To sRGB 
Profile. If necessary, use a 

Hue/Saturation adjustment layer to 
alter the image so it looks good to 
you and then save a master copy for 
future edits by choosing File → Save 
As and picking Photoshop from the 
Format menu. To create a copy you 
can upload to a printing service, 
choose File → Save As again and pick 

SOFT PROOFING 
IN Photoshop is 
incredibly easy.

AFTER CONVERTING TO sRGB in Elements, save the file with a different name so you don’t 
overwrite the original.
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JPEG from the Format menu. In the 
resulting quality dialog box, enter 12 
and click OK.

In Photoshop Lightroom 4 or later, 
open an image in the Develop module 
and then turn on the Soft Proofing 
check box beneath the image preview 
(or press T on your keyboard). In the 
Soft Proofing panel at upper right, 
choose sRGB from the Profile menu 
and any problematic areas appear in 
red. In order to fix the image without 
altering the current version, click 

Create Proof Copy and then try using 
the HSL panel to tweak the colors and 
eliminate the red warning. When 
you’re finished, choose File → Export 
and in the resulting dialog box, scroll 
down to the File Settings section and 
choose sRGB from the Color Space 
menu, set the Quality field to 100, and 
then click Export.

As you can see, it’s important to 
preview your images in the color 
space in which online printers 
actually use. ■ 
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LIGHTROOM 
HIGHLIGHTS PROBLEM 
areas in red so you 
can easily spot them.
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Created a gorgeous slideshow in Photos? Here’s how you can share it 
with your friends and family.

BY LESA SNIDER

How to share slideshows 
created in Photos for Mac
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SHARE SLIDESHOWSCREATE

W hen it comes to showing off your pictures and mov-
ies, nothing beats a great slideshow, and the ones 
you can craft in Photos for Mac are gorgeous. You 
can also export a saved slideshow project as a 

movie in order to share it with others.

However, the way you share 
exported slideshow movies depends 
on the capability of your recipient. Do 
they have a computer? Do they have 
an Apple TV? Do they have a DVD or 
Blu-ray video player? Will you be 
there in person with an iOS device? 
In this column, you’ll learn strategies 
for each of these situations.

HOW TO EXPORT A SAVED 
SLIDESHOW AS A MOVIE
Once you finish crafting a saved 
slideshow—made by choosing File → 
Create Slideshow or by clicking the + 
(plus-sign) icon and choosing Slide-
show—you can export it in .m4v format 
in a variety of sizes. If you’re in Projects 
view and the slideshow is open, click 
Export at the upper right of Photos’ 
toolbar to get the party started.

If the project is selected in Projects 
view but not open, choose File → 
Export → Export Slideshow. Either 
way, the Export pane appears, which 
lets you name the movie, pick a size, 
and tell Photos where to save it. Your 
format (size) options include:

Standard Definition (480p). This 
option produces a 640-by-480-pixel 

movie, which is great for transferring 
onto an older iOS device (iPod touch 
3rd generation, iPhone 3GS, iPad 1, 
and 1st generation Apple TVs). It 
produces the smallest file size, so it’s 
a good choice if you plan to share 
the slideshow with someone who 
doesn’t have high-speed Internet 
access (gasp!).

High Definition (720p). This option 
produces a 1280-by-720-pixel movie, 
which makes for a larger file size but 
it looks fantastic onscreen. It’s perfect 

AN EXPORT BUTTON 
appears at upper right 
whenever a saved 
slideshow project is 
open.
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for newer but not the newest iOS 
gadgets such as a 4th generation 
iPod touch, iPhone 4, iPad, 2nd 
generation Apple TVs, for posting 
onto Facebook or YouTube, or for 
sharing via file-transfer services like 
iCloud Drive or Dropbox (more on 
those services in a bit).

High Definition (1080p). Choose 
this option for a stunning 1920-by-
1080-pixel movie, which is what you 
want for viewing on the latest iOS 
devices, Apple TVs, and TV screens. 
The file size will be humongous, but 
the movie will look awesome.

HOW TO SHARE THE 
EXPORTED MOVIE
As mentioned earlier, how you share 
the exported movie depends on your 
recipient’s equipment and whether or 
not you’ll be there in person. Below 
are some common scenarios and 
how to handle them.

IF THE RECIPIENT HAS A 
COMPUTER (MAC OR 
WINDOWS)
Method 1: Upload the exported 
movie to a file sharing service such 
as Dropbox, Box.com, Google Drive, 
OneDrive, or MediaFire, and then 
send the recipient an email with a 
link to download the movie onto their 
computer. (iCloud Drive won’t work in 
this situation because to download 
the movie, the recipient has to sign in 

with your iCloud credentials.)
Method 2: Copy the exported 

movie to a USB flash drive, CD, or 
DVD and then physically mail it to 
them (preferably with instructions for 
playing it). For example, your recipi-
ent must insert the disc or attach the 
flash drive to their computer and 
double-click the movie file to play it.

To copy your slideshow to a USB 
flash drive, drag the movie file onto 
the drive. To burn the movie to a CD 
or DVD, you need an optical drive, 
which newer Macs lack. When you 
burn an exported movie onto a CD or 
DVD, you create a data disc (not a 
video disc), which is like sharing files 
on a USB flash drive. To copy the 
movie onto a blank CD or DVD, insert 
the disc into your Mac’s optical drive, 
or an external one, and then drag the 
file onto the disc icon on the desk-
top. When you eject the disc, your 
Mac offers to burn the files onto  

IF YOU HAVE an iOS 
device, turn on 
Automatically Send 
To iTunes so you 
can sync the movie 
onto your gadget, as 
described later.
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the disc.
It’s worth noting that the 

movie(s) on the disc won’t 
play automatically when 
your recipient inserts the 
disc; they have to tell the 
computer which file to play. 
On a Mac, double-click the 
movie to launch QuickTime 
Player and then click the 
play button. (On Windows-
based PCs, the file may 
open in Windows Media 
Player instead, or the user 
can download QuickTime.)

Method 3: If your Mac’s 
running OS X Yosemite or later and 
you’re signed into your iCloud 
account, you can use the Apple Mail 
app to email the movie using OS X’s 
Mail Drop feature. To do that, attach 
the exported movie to an email and 
then click Send. If your recipient is 
also running OS X Yosemite or later 
and using Apple Mail, the movie file 
appears as an attachment to the 
email message. If they’re running an 
earlier version of OS X, Windows, or 
using a different email app, they’ll 
see a link to download the movie. 
Happily, Mail Drop file transfers don’t 
count against your total iCloud 
storage allotment. However, if your 
recipient’s email provider doesn’t 
allow them to receive large attach-
ments, your message may be 
returned as undeliverable.

IF THEY DON’T HAVE A 
COMPUTER, BUT THEY  
DO HAVE A DVD OR  
BLU-RAY VIDEO PLAYER 
ATTACHED TO THEIR TV
Use the instructions in method 2 in 
the previous section to burn the 
movie onto a CD or DVD and then 
physically mail it to your recipient 
with instructions on how to play it. It’s 
worth noting that the movie(s) on the 
disc won’t play automatically when 
your recipient inserts the disc; to play 
the movie using a DVD or Blu-ray 
player, use the arrow keys on the 
player’s remote to navigate to the file 
and then click the remote’s play 
button to fire it up. Not all DVD and 
Blu-ray players can play an .m4v file. 
To maximize the likelihood of it 
playing, change its filename exten-

COPYING YOUR MOVIE 
file to a USB flash 
drive is a drag-and-
drop affair.
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sion from “.m4v” to “.mp4” before 
burning it to disc.

IF THEY HAVE AN APPLE  
TV AND YOU’LL BE THERE  
IN PERSON
If you can be there in person and you 
have a newer MacBook or iOS 
device, you can use AirPlay to 
broadcast the movie onto your 
recipient’s AppleTV-connected TV 
screen. To learn how, see Dan 
Frakes’ video, Get started with 
AirPlay (go.macworld.com/airplay-
howto). To sync the movie on your 
iOS device, keep reading.

IF YOU’LL BE THERE IN 
PERSON AND YOU WANT  
TO PLAY THE MOVIE ON  
YOUR iOS DEVICE
Method 1: Use iCloud Drive. iCloud 
Drive is the name for 
the online storage 
space you get with 
an iCloud account. 
When you upload 
files to iCloud Drive, 
you can download 
them onto another 
computer—Mac or a 
PC running Windows 
7 or later—or any iOS 
device that’s signed 
into your iCloud 
account. Files can be 
up to 15GB in size, 

but you can’t exceed your overall 
iCloud storage limit. To do it, go to 
the Finder on your Mac and choose 
Go → iCloud Drive to open an iCloud 
Drive window, and then drag the 
movie into the window. Alternatively, 
you can expand Photos’ Export pane 
and choose iCloud Drive from the 
Favorites list that appears on the left.

Annoyingly, downloading files from 
iCloud Drive onto an iOS device 
requires some effort. First, enable the 
iCloud Drive app inside the iCloud 
settings on an iOS device running iOS 
9 or higher. Second, you have to play 
the movie in the iCloud Drive app 
while you have an Internet connection 
in order to download it. So launch the 
iCloud Drive app on your iOS device 
and in the resulting window, tap the 
movie file to play it. For more on using 
iCloud Drive, see Leah Yamshon’s 

IN ORDER TO sync an 
exported movie onto 
your iOS device(s), 
you must first turn on 
Sync Movies.
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story, Hands-on with iCloud Drive (go.
macworld.com/ios9icloud), a brand-
new app in iOS 9.

Method 2: Sync via iTunes. If you 
turned on the Automatically Send To 
iTunes feature in Photos’ Export 
pane, your movie already lives in 
iTunes in the Home Videos section  
of the Movies category. If you didn’t, 
you can always drag the file onto the 
iTunes window to import it.

Attach your iOS device to your 
Mac and pick it from the device list 

near the upper left. In the Settings 
section on the left, choose Movies 
and then turn on Sync Movies. Turn 
on the checkbox of the movie you 
want to sync and then click the Apply 
button at lower right to trigger a 
sync. The synced video ends up in 
the Videos app on your iOS device in 
the Home Videos section.

As you can see, sharing exported 
slideshow movies takes some doing, 
but it’s well worth the effort. ■

SHARE SLIDESHOWSCREATE

http://www.softgozar.com


News, tips, and reviews about smart homes,  
home security, and home entertainment.

TechHive helps you find your  
tech sweet spot. 

We steer you to smart-home tech products you’ll love 
and show you how to get the most out of them. 

www.techhive.com  |  Follow us

http://www.softgozar.com


128

HELP DESK Answering Your Questions and Sharing Your 
Tips About Getting the Most From Your Mac

Mac 911
Solutions to your most vexing Mac problems.

BY GLENN FLEISHMAN

Is it sensible to combine backup types on a single drive?

Q: I have been using Time Machine for years. I am now considering adding 
SuperDuper and/or Carbon Copy Cloner (CCC) as additional backup tools. 
Can I just use these on the same external hard-disk drive as where my TM 
backups reside, or do I have to partition it?

— George Lai
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A: I have a bit of philosophy to go 
along with the pragmatic answer. The 
philosophy is: “Don’t put all your 
eggs in one basket.” Having 
incrementally updated full-drive Time 
Machine backups on the same 
physical volume as drive clones 
seems like a fundamentally bad idea. 
If something goes wrong with the 
physical mechanism, it renders both 
kinds of backups bad.

I like to combine dissimilar back-
ups for the greatest potential benefit. 
SuperDuper and CCC scan a whole 
drive but don’t require the installation 
of background scanning software, 
unlike third-party automatic incre-
mental backup services and software 
(like Backblaze and CrashPlan). The 
clone software can be set to run at 
an automatic interval, and gives you 
an instantly restorable boot volume. 
Time Machine can do the same, but it 
requires more effort; its main benefit 
is continuous backups with multiple 
versions.

Putting both on the same physical 
drive means both could fail at 
once—although it’s unlikely that your 
computer’s drive and external drive 
would fail simultaneously without a 
fire or other disaster, or both be 
unavailable at once without a theft. 
My preferred combo is a local nightly 
clone and continuous incremental 
remote backups of all useful files. I 

also try to make clones that I rou-
tinely take offsite for extra security.

All that philosophy out of the way, 
it’s quite easy to use a single drive 
for multiple backups. If the drive is 
big enough relative to your internal 
drive, a logical partition makes sense 
just for clarity: Time Machine goes on 
one, and the clone 
on the other.

However, both 
SuperDuper and 
CCC can use a 
disk image to 
create a clone, in 
which case you can have a 
single partition, and save 
the clone disk image onto 
the same volume that’s 
being used for Time 
Machine. I suggest it’s better to get 
two drives, even though that adds 
requirements for ports, power, cost, 
and noise, for the best possible 
outcome. But it’s not necessary.

Deleting items instantly or 
selectively from Trash.

A: I frequently use flash drives for 
backup and transferring files from 
one computer to another. I often 
want to delete one or two files from 
a flash drive without emptying the 
trash. Is there any way to do this?

— Len

I LIKE TO COMBINE 
DISSIMILAR BACKUPS 
FOR THE GREATEST 
POTENTIAL BENEFIT. 
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to see Delete Immediately. (You can 
also press Command-Option-Delete 
for the same effect.)

This is also useful in the Trash, as 
you can select items in the Trash and 
Control-click to get Delete Immedi-
ately as a contextual menu item.

However you invoke it, Delete 
Immediately first prompts you to 
confirm the action and then erases 
the filesystem’s knowledge of the 
item or items selected right away, 
rather than pushing it through the 
Move To Trash and Empty Trash cycle. 
(As previously described, though, 
deleting files doesn’t securely erase 
them (go.macworld.com/secureemp-
tytrash) without extra effort.)

Does your photo have the 
wrong timestamp? Here’s 
how to fix it

Q: Recently, I took a vacation to 
Alaska. I used my iPhone, which 
reset to the local time, and a 
point-and-shoot camera that I 
forgot was still set to EDT. After 
importing the photos to my Mac, 
I’ve found the time sequences are 
wrong and the photos are in the 
wrong order because of the 
differences in the two cameras’ 
settings. How can I edit the wrong 
times?

— Lee Perrin

A: Starting in El Capitan, you’ve got an 
option for precisely this purpose. While 
I don’t use the Trash as a temporary 
repository—a kind of purgatory 
between an active file and the final bit 
bucket in the sky—but rather only for 
items I want to get rid of, many people I 
know stow stuff in Trash they think they 
might delete later.

Before El Capitan, you would have 
had to drag items out of the Trash to 
delete only those that remain. 
However, OS X 10.11 adds Delete 
Immediately. You can select any item 
or set of items in the Finder, hold 
down Option, and click the File menu 

CONTROL-CLICK AN ITEM or items in the Trash, and 
the Delete Immediately menu item appears.
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A: You’re in luck, as 
there are multiple ways 
to fix this.

In iPhoto. If you’re 
still using iPhoto and 
you’ve imported the 
images there, you can 
use a long-standing 
adjustment feature. 
Select the images, then 
select Photos → Adjust 
Date And Time. You can 
make a change to the 
first image, and iPhoto will calculate 
how to apply that to all selected 
images and explain that to you before 
it’s applied. Shift the time by four hours 
on the first and iPhoto will offer to do 

the same to the full selection with the 
option to apply to the original images.

In Photos. In Image → Adjust Date 
And Time, you can use an improved 
version of the same feature from 
iPhoto. The Photos version lets you 
use a graphical world map to shift 
time zones. It has the same clever-
ness about applying a shift to all 
images instead of setting the 
precise time for all images to your 
adjustment.

In A Better Finder Attributes. If 
the media remains unimported, your 
best bet is the $15 utility A Better 
Finder Attributes (go.macworld.com/
abetterfindersatt). It can modify all 
sorts of file-related data, which 
includes the EXIF metadata embed-
ded in images. Adjust EXIF Time-
stamp lets you pick a specific time 
offset. ■

A BETTER FINDER 
Attributes allows 
adding or removing 
time offsets from the 
embedded metadata 
of images.

Ask Mac 911
We’re always looking for problems 
to solve! Email us at mac911@
macworld.com, tweet them at me (if 
brief) @glennf, or call 206-337-5833 
and leave a voicemail message. 
(We’ll be experimenting with some 
audio in the future, and may put 
your question “on the air.”)

Mac 911 can’t provide direct email 
responses or answers for every 
question. For that, turn to Apple-
Care, an Apple Store Genius Bar, or 
the Apple Support Communities.
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